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INFORMACION GENERAL

Derechos de autor

Este manual y todo su contenido estan sujetos a derechos de autor. Reservados todos los
derechos. Queda prohibido reproducir, copiar, traducir o transmitir alguna parte de este
Manual de instrucciones, de ningun modo y por ningun medio, sin la autorizacion previa
por escrito de Genea Biomedx.

iPod® y iPod® touch son marcas registradas de Apple Inc.®

RENUNCIA DE RESPONSABILIDAD POR MATERIALES,
PRODUCTOS Y SERVICIOS DE TERCEROS

La instalacion y el uso de GIDGET pueden involucrar materiales, productos o servicios
subyacentes de terceros que incluyen, entre otros, impresoras, etiquetas, base

escaner portatil y acceso a Internet. GENEA Y SUS DISTRIBUIDORES RECHAZAN
CUALQUIER Y TODA RESPONSABILIDAD, INCUIDA CUALQUIER GARANTIA
EXPRESA O IMPLICITA, YA SEA ORAL O ESCRITA, POR DICHOS MATERIALES,
PRODUCTOS O SERVICIOS DE TERCEROS. EL CLIENTE RECONOCE QUE
GENEA O SUS DISTRIBUIDORES NO HAN HECHO UNA REPRESENTACION EN
CUANTO A LA ADECUACION DE LOS MATERIALES, PRODUCTOS O SERVICIOS DE
TERCEROS PARA EL PROPOSITO OBIJETIVO DEL CLIENTE.

Asistencia técnica

Genea Biomedx Pty Ltd

Level 2, 321 Kent Street

Sydney, New South Wales, 2000, Australia
Correo electronico: info@geneabiomedx.com
Pagina web: www.geneabiomedx.com

QIFU-GIDG-ES-1 revision 1 traducida del material original QFRM883 revision 8.
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1. ACERCA DE GIDGET

1.1. Descripcion general

Gidget es un sistema electronico para la identificacion de muestras de pacientes y la
gestion de la secuencia de flujo de trabajo de procedimientos de reproduccion asistida en
un entorno clinico y de laboratorio. Gidget puede ser manejado por una sola persona para
identificar y asociar muestras de pacientes a lo largo del flujo de trabajo de laboratorio. El
sistema emplea un codigo de barras Unico para cada paciente que puede imprimirse en
etiquetas y fijarse a los contenedores y a la documentacion asociados a ese paciente.

El sistema Gidget esta formado por los escaneres escaner portatiles Gidget y un sistema
de computacioén central de Gidget. El escaner lee los cédigos de barras y el software
confirma que la informacion de paciente coincide. Mediante una conexién inalambrica,

se registran todas las transferencias en una base de datos del sistema de computacion
central de Gidget que guarda un registro de todos los usuarios y todas las etiquetas
escaneadas en el sistema, ademas de cualquier error o advertencia que se produzca. Los
Informes de auditoria se pueden visualizar, exportar o imprimir. La informacion del sistema
Gidget se muestra a través de la aplicacion web Gidget.

Impresoras de Escaneres
| . +more . |
aboratorio printers , %qcrjtatl es
\ // I get
i——-l % o
\ | i

W Handheld ~ ¥

3 Scanners *
l \\ N Mo
\ \ \\
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computacion scanners Router de
central de Gidget D laboratorio

ml Dashboard

Monitor opcional
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Ordenador de
sobremesa de Jj N
laboratorio  AFEEEEEEENT

1.2. Uso previsto

Gidget esta pensado como un sistema electrénico para la identificacion de muestras

de pacientes y la gestion de la secuencia de flujo de trabajo de procedimientos de
reproduccion asistida en entornos de clinicas IVF y de laboratorio. Gidget esta disefiado
para ayudar a los usuarios durante las sesiones de testigo y no para sustituir o alterar la
obligacion por parte de los usuarios de leer y confirmar las etiquetas.
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1.3. Caracteristicas

El sistema Gidget proporciona una serie de caracteristicas para apoyar a los cientificos en
el laboratorio.

Visibilidad del flujo de trabajo:

El progreso del flujo de trabajo se organiza por Dias de ciclo, y se muestra en cualquier
ordenador de sobremesa adecuado y en el Escaner portatil Gidget. Gidget también
permite la monitorizacion desde un monitor opcional montado en pared para ofrecer una
mayor visibilidad del flujo de trabajo.

Seguimiento del flujo de trabajo:

Los supervisores y administradores de laboratorio definen practicas de flujo de trabajo,
incluyendo el numero y tipo de contenedores que se deben escanear en cada Ciclo, y en
qué Dia de ciclo se deben escanear.

Alertas de error:
Todos los errores y advertencias se resaltan y registran en cuanto ocurren.

Testigo electronico:
Se escanean las etiquetas para identificar las muestras de pacientes y realizar funciones
de testigo. Las muestras se pueden identificar a nivel de embriones y gametos.

Etiquetado:

Se generan etiquetas de paciente con codigo de barras Unico y se asignan a dias
especificos dentro del Ciclo del paciente antes de realizar cualquier Procedimiento.
Durante los Procedimientos, estas etiquetas se escanean siempre que se requiera testigo.

Trazabilidad e Informes:

Gidget permite visualizar y exportar Informes de auditoria. Los informes contienen un
registro completo de las actividades realizadas con el escaner, incluidos todos los errores,
advertencias y sesiones incompletas.

Seguimiento de consumibles:

Cualquier consumible utilizado como parte del procesamiento de la muestra puede
registrarse, vincularse a los Ciclos del paciente e incluirse en informes para ayudar en la
gestion del laboratorio.
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1.4. Elementos incluidos

Los elementos que se enumeran a continuacion se suministran con Gidget:

= Pack de escaner Gidget. GIDG-SCAN-01
— 1 escaner portatil Gidget
1 estacion de carga

Sistema de computacién central de Gidget. GIDG-CCS-01

— 1 sistema de computacion central de Gidget (CCS) con software Gidget
1 fuente de alimentacion

1 manual de instrucciones de Gidget

Si es necesario, hay disponibles escaneres y cargadores Gidget adicionales. Para mas
informacién, pongase en contacto con el representante local autorizado. GIDG-SCAN-01.
1.5. Elementos recomendados

Tarjetas de plastico con cordon para las etiquetas de ID de usuario impresas

Monitor de pantalla plana montado en pared (requiere la conexion al monitor de un
PC en una memoria USB o de un ordenador escaner portatil o de sobremesa)
Navegador web Google Chrome
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1.6. Simbolos usados en Gidget

Cancelar sesién de testigo

Icono Descripcion Icono Descripcion
] : : ,
Q@ Paciente activo 0 Testigo manual
Anadir @ Etiqueta atestiguada
manualmente
Auditoria — Menu desplegable
Atras r. Etiqueta multicomponente
Cancelar 9 Siguiente
«@

Lista de pacientes

3O X 1 =+

Confirmar {.'. Preparar Ciclo de paciente
|
Ciclo E.a Imprimir configuracion
U U
Fecha .@ Solicitud de compra de licencia
“n Eliminar B Guardar
,0 Editar III Descongelar
m Exportar (?a Ciclo de descongelado
= Historia “ Desbloquear paciente

Proceso de laboratorio

[
{1

Sesion de testigo

B | & [0

Error critico

)¢

Critico
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Advertencia

Existe un ciclo previo

Impresora por defecto Procedimiento vinculado

Reordenar Procedimiento Desvincular Procedimiento

Completar dia Reanudar dia

Completar Ciclo Siguiente

Procedimiento actual Desviacion del flujo de trabajo

Cancelar ciclo Completar ciclo

Activar lote de consumibles Cerrar lote de consumibles

N3N O QB

e A CEIEIRE
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2. CONFIGURACION BASICA

Su técnico de servicio local autorizado instalara Gidget y colaborara estrechamente con
usted para configurar el sistema de acuerdo con los requisitos de su laboratorio.

Una vez instalado y configurado, solo los usuarios autorizados como supervisores y
administradores podran acceder a las pantallas de configuracion y gestion de Gidget.

2.1. Configuracion

La pantalla «Settings» (Configuracion) permite realizar la configuracion basica de la
aplicacion web Gidget.

Para acceder a la configuracion: seleccione «Settings» (Configuracion) en el menu
desplegable ubicado en la esquina superior derecha de la pantalla. Se mostrara la pantalla
«Settings» (Configuracion).

Para guardar cambios: haga clic en [*) para guardar cualquier cambio. NOTA: el icono
de guardado solo aparece si se han realizado cambios en la pantalla de configuracién.

Desde la pantalla de configuracion es posible modificar las siguientes opciones:

«Language» (Idioma):

La version inicial de Gidget solo esta disponible en inglés, incluidos caracteres especiales
y marcas diacriticas (puede que haya mas idiomas disponibles en futuras actualizaciones
del software).

«Automatic Logout After» (Cerrar sesién automaticamente después de):

Esta funcion permite a los supervisores o administradores de laboratorio ajustar un
tiempo de inactividad especifico después del cual se cerrara la sesion de usuario
automaticamente (en intervalos de cinco minutos hasta un maximo de 60 minutos).

«Account Number» (Nimero de cuenta):
El numero de cuenta se facilita durante la instalaciéon y configuracion.

«Site Name» (Nombre del centro):

El nombre del centro es una descripcién del centro definida por el usuario que aparecera
en los Informes para identificar a la clinica o laboratorio individual. NOTA: Los nombres de
centros no deberian tener una longitud superior a 20 caracteres.

«Remaining License Warning at» (Advertencia de licencias restantes en):

Esta funcion permite a los supervisores y administradores de laboratorio ajustar el umbral
de advertencia de ciclos restantes disponibles en una licencia.

«License Requisition E-mail» (Correo electrénico de solicitud de licencia):

Esta funcion permite a los supervisores y administradores de laboratorio especificar la
direccion de correo electronico a la que se envian las solicitudes de compra de licencia

«Country Identifier» (Identificador de pais):

Esto permite a los supervisores o administradores de laboratorio especificar un
identificador de 2 caracteres que aparecera como parte del Codigo Unico Europeo (SEC).
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Codigo TE:
Esto permite a los supervisores o administradores de laboratorio especificar un Codigo TE
de 6 caracteres que aparecera como parte del Codigo Unico Europeo (SEC).

Variable de etiqueta 1:

Esto permite a los supervisores o administradores del laboratorio especificar si la
Variable 1 en la etiqueta del SEC aparecera como Apellido, Numero de paciente o
permanecera en blanco. (NOTA: el valor predeterminado para la variable de etiqueta
SEC es <blank>).

2.2. Anadir un usuario

Solo los supervisores y administradores pueden afadir usuarios individuales a Gidget.
Durante este proceso, se asigna un Nombre de usuario, un PIN y un ID de usuario a
los usuarios, lo cual les permite iniciar sesion y utilizar la aplicacion web y el escaner de
Gidget.

Para anadir un usuario:

1. Haga clic en «User Management» (Administracién de usuarios) en el menu
desplegable ubicado en la esquina superior derecha de la pantalla. Se muestra la
pantalla «User Management» (Administracién de usuarios).

2. Hagaclic en + enla esquina superior derecha de la pantalla. Se muestra la
pantalla «User Settings» (Configuracion de usuario).

3. Indique el nombre del nuevo usuario.
4. Indique la direccién de correo electrénico (opcional).

o

Seleccione el Nivel de usuario («<Admin», «Supervisor» o «<Embryologist»
[Administrador, Supervisor o Embridlogo]) en el menu desplegable «Level» (Nivel).

Anada el nombre de usuario deseado en «User Name».
Anada el nimero PIN deseado del usuario.
Confirme el numero PIN.

©® N o

Haga clic en [ para guardar los cambios y afadir el usuario o en ¢« para cancelar.
10. Repita los pasos anteriores para afiadir mas usuarios.

) | Admin =
&
Name v Email v Username v Level v Active +
Last+First name #1 example@email.com User name Admin [ &)
Last+First name #2 example@email.com User name Supervisor [ =
Last+First name #3 example@email.com User name Embryologist | |
NOTA:

» La aplicacion web Gidget incluye una cuarta funcion, «<Dashboard» (Panel de control).
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Al iniciar sesion como «Dashboard» se mostrara una version no interactiva de la pantalla
«Active Patients» (Pacientes activos) que se puede emplear en una pantalla montada en
pared de un laboratorio para maximizar la visibilidad del flujo de trabajo. Este usuario no
cerrard su sesion tras 24 horas. Péngase en contacto con su representante de servicio
autorizado para obtener mas informacion sobre el uso de esta funcion.

* Los campos obligatorios se indican mediante un asterisco.

2.3. Modificar un usuario
Para modificar la informacién de un usuario:

1. Haga clic en «User Management» (Administraciéon de usuarios) en el menu
desplegable ubicado en la esquina superior derecha de la pantalla. Se muestra la
pantalla «User Management» (Administracion de usuarios).

2. Desplace el cursor sobre la fila del usuario deseado y haga clic en # cuando
aparezca. Se muestra la pantalla «User Settings» (Configuracién de usuario).

3. Modifique la informacion necesaria.
4. Haga clic en [%] para guardar cualquier cambio o en < para cancelar.

2.4. Reactivar un usuario

Si un usuario queda bloqueado sin acceso a Gidget, debera reactivarse su estado (el
usuario puede, por ejemplo haber introducido su PIN incorrectamente tres veces).
Para reactivar un usuario:

1. Haga clic en «User Management» (Administracion de usuarios) en el menu
desplegable ubicado en la esquina superior derecha de la pantalla. Se muestra la
pantalla «User Management» (Administracion de usuarios).

2. Localice al usuario deseado.

3. Haga clic en el selector en la columna «Active» (Activo) junto al usuario adecuado
para @] (activar).

2.5. Desactivar un usuario

1. Haga clic en «User Management» (Administracion de usuarios) en el menu
desplegable ubicado en la esquina superior derecha de la pantalla. Se muestra la
pantalla «User Management» (Administracion de usuarios).

2. Localice al usuario deseado.

3. Haga clic en el selector en la columna «Active» (Activo) junto al usuario adecuado
para [ I (desactivar).

2.6. Seleccionar una impresora
Para seleccionar una impresora:

1. Haga clic en «User Management» (Administracion de usuarios) en el menu
desplegable ubicado en la esquina superior derecha de la pantalla. Se muestra la
pantalla «User Management» (Administracion de usuarios).

2. Hagaclic en 'Eé,, en la esquina superior derecha de la pantalla. Se muestra la pantalla
«User Label Print Settings» (Configuracion de impresion de etiqueta de usuario).

Seleccione la impresora deseada del menu desplegable «Printer» (Impresora).
Haga clic en [5) para guardar cualquier cambio o en & para cancelar.

> w
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2.7. Imprimir una ID de usuario

Se recomienda que esta ID de usuario esté impresa en una etiqueta y fijada a una
tarjeta de plastico o cordodn para que los usuarios la lleven consigo en el laboratorio. Se
recomienda que esta ID de usuario esté impresa en una etiqueta y fijada a una tarjeta de
plastico o cordon para que los usuario la lleven consigo en el laboratorio.

NOTA: Asegurese de que la impresora adecuada esta instalada o disponible antes de imprimir.

Para imprimir una etiqueta de ID de usuario:

1. 1. Haga clic en «User Management» (Administracion de usuarios) en el mend
desplegable ubicado en la esquina superior derecha de la pantalla. Se muestra la
pantalla «User Management» (Administracién de usuarios).

2. 2. Situe el cursor sobre la fila del usuario deseado.
3. Haga clic en ®8 cuando aparezca a la derecha de la fila del usuario.

4. Aparecera una ventana emergente para confirmar la impresion, y luego se imprimira
la etiqueta.

2.8. Licencias

Las licencias de Gidget son necesarias para cada ciclo utilizado en el sistema Gidget y
pueden adquirirse en lotes de 50, 100, 500 y 1000 ciclos. Se proporciona una clave de
licencia con cada licencia.

Licencia Gidget de 50 ciclos: GIDG-LIC-50.
Licencia Gidget de 100 ciclos: GIDG-LIC-100.
Licencia Gidget de 500 ciclos: GIDG-LIC-500.
Licencia Gidget de 1000 ciclos: GIDG-LIC-1000.

Para anadir una licencia:
NOTA: Se requiere una clave de licencia para afiadir una licencia.

1. Haga clic en «Licenses» (Licencias) en el menu desplegable ubicado en la esquina
superior derecha de la pantalla. Se mostrara la pantalla «Licenses» (Licencias).

2. Haga clic en 4+, enla esquina superior derecha de la pantalla. Se mostrara la
pantalla «<Enter Purchased License» (Introducir licencia adquirida).

3. 3. Introduzca la clave de licencia proporcionada.
4. Haga clic en [®] para guardar cualquier cambio o en ¢ para cancelar.

La licencia aparecera ahora en la ventana «License History» (Historial de licencias) y el
numero de ciclos restantes de la licencia aparecera junto a «Cycles Remaining» (Ciclos
restantes).

Para solicitar una nueva licencia:

1. Haga clic en «Licenses» (Licencias) en el menu desplegable ubicado en la esquina
superior derecha de la pantalla. Se mostrara la pantalla «Licenses» (Licencias).

2. Haga clic en Z, en la esquina superior derecha de la pantalla. Aparecera una
ventana de correo electronico emergente dirigida a su proveedor de licencias.
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3. Afada el cédigo de la licencia para el nimero de ciclos requerido (véase
«Licencias» mas arriba).

4. Haga clic en enviar.

NOTA: La direccion del correo electronico de solicitud de licencia puede modificarse

en el menu desplegable «Settings» (Configuracion) (véase ““2.1. Configuracion” en la
pagina 6).

Pagina 10 de 63 QIFU-GIDG-ES-1-01



MANUAL DE INSTRUCCIONES DE GIDGET

3. PROCESO DE LABORATORIO

Gidget se puede personalizar para adaptarse a los procesos concretos del laboratorio a la
vez que mantiene un seguimiento de los procesos en que se requiera testigo.

Para acceder a la pantalla «Lab Process» (Proceso de laboratorio): haga clic en «Lab
Process» (Proceso de laboratorio) en el menu desplegable ubicado en la esquina superior
derecha de la pantalla. Se muestra la pantalla «<Lab Process» (Proceso de laboratorio).

NOTA: Los tres pasos de proceso de laboratorio mostrados en la pantalla «Lab Process»
(«1 Label Library», <2 Procedures» y «3 Cycle Types» [1 Biblioteca de etiquetas, 2
Procedimientos y 3 Tipos de ciclo]gldeben llevarse a cabo en orden, y permaneceran
desactivados (en gris) hasta que se complete el paso anterior.

3.1. La biblioteca de etiquetas

La «Label Library» (Biblioteca de etiquetas) se utiliza para crear y dar formato a las
etiquetas para los contenedores y archivos y documentos necesarios para el proceso de
testigo electronico de las muestras de pacientes.

3.1.1. Dar formato a las etiquetas
Para dar formato a las etiquetas:

1. Haga clic en «Lab Process» (Proceso de laboratorio) en el menu desplegable
ubicado en la esquina superior derecha de la pantalla. Se muestra la pantalla «Lab
Process» (Proceso de laboratorio).

2. Haga clic en «1 Label Library» (1 Biblioteca de etiquetas) en la pantalla «Lab
Process» (Proceso de laboratorio). Se muestra la pantalla «Define Label Library»
(Definir biblioteca de etiquetas).

Haga clic en +, en la parte superior de la columna «Label Formats» (Formatos de
etiqueta). Se muestra la pantalla «Define Label Format» (Definir formato de etiqueta).

Cree un nombre descriptivo para el formato (por ejemplo, pequefia, mediana o grande).
Seleccione la etiqueta apropiada del menu desplegable «Stock» (Repertorio).
Seleccione la impresora deseada del menu desplegable «Printer» (Impresora).

Especifique las variables para cada etiqueta que utilizara este formato de etiqueta
en el laboratorio.

. J . .
Haga clic en [¥] para guardar cualquier cambio o en « para cancelar.
) | Admin =

w

No o

@

Label Formats + Partner/ Oocyte g\ ooate +

Label Name v Label Format v Owner
Sperm... Donor

Small, Brady 25 x 12.5mm Al Sperm Small o ° ©) )

Patient Last Name
Patient #
Date of birth m-l And Rcp Small ° o o

Container Type

And Spl Small ° o o o

Large, Brady 50 x 25mm

(o]
o

BET Small o o

Patient Last Name
Patient #
Date of birth

Gender
Address

BIOP Small ° o o o
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Una vez guardado el formato de etiqueta, la nueva etiqueta aparecera en la columna «Label Formats»
(Formatos de etiqueta) en la pantalla «Define Label Library» (Definir biblioteca de etiquetas).

NOTA:

Las variables disponibles mostradas dependeran del repertorio seleccionado.

Se recomienda dar a una de las variables el nombre «Container Type» (Tipo
contenedor) para facilitar el emparejamiento de una etiqueta impresa con el tipo de
contenedor correcto.

Puede imprimir una muestra haciendo clic en @, en la esquina superior derecha
de la pantalla «Define Label Format» (Definir formato de etiqueta).

No es necesario tener una impresora conectada para crear formatos de etiqueta.

Solo las etiquetas Wrap-around y Gavi 7-set pueden designarse como “nivel de
muestra” aplicada a embriones, gametos y tubos de biopsia. Las etiquetas Gavi
7-set pequefias, (es decir, “pod”) son de “nivel de muestra”, pero la etiqueta
grande (es decir, “cassette”? se comporta como ciclo del paciente.

Example Variable1 | <blank> v

Variable3 | <blank> -

|
Variable 2 [<b|ank> v l
|
|

Variable 4 | <blank> v

;
ke

Example Variable1  Patient name

Variable2  Patient #

Variable 3 | Freeze date v

Variable4  Sample #

3.1.2. Modificar formatos de etiquetas
Para modificar formatos de etiquetas:

1.

Haga clic en «Lab Process» (Proceso de laboratorio) en el menu desplegable
ubicado en la esquina superior derecha de la pantalla. Se muestra la pantalla «Lab
Process» (Proceso de laboratorio).

Haga clic en «1 Label Library» (1 Biblioteca de etiquetas) en la pantalla «<Lab
Process» (Proceso de laboratorio). Se muestra la pantalla «Define Label Library»
(Definir biblioteca de etiquetas).

Haga clic en la etiqueta deseada de la columna «Label Formats» (Formatos de
etiqueta). Aparecera la pantalla «Define Label Format» (Definir formato de etiqueta)
para esa etiqueta concreta.

Realice los cambios deseados.

Haga clic en [5) para guardar cualquier cambio o en & para cancelar.
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3.1.3. Anadir etiquetas

Para anadir etiquetas:

1. Haga clic en «Lab Process» (Proceso de laboratorio) en el menu desplegable
ubicado en la esquina superior derecha de la pantalla. Se muestra la pantalla «Lab
Process» (Proceso de laboratorio).

2. Haga clic en «1 Label Library» (1 Biblioteca de etiquetas) en la pantalla «Lab
Process» (Proceso de laboratorio). Se muestra la pantalla «Define Label Library»
(Definir biblioteca de etiquetas).

3. Hagaclic en +.,enla esquina superior derecha de la pantalla. Se muestra la
pantalla «Define Label» (Definir etiqueta).

4. Indique un nombre para el contenedor al que se asociara la etiqueta. Esto se utiliza
para rellenar la variable «Container Type» (Tipo de contenedor) en el formato de la
etiqueta (por ejemplo, OPU).

5. Seleccione el formato deseado del menu desplegable «Format» (Formato). NOTA:
asegurese de que el tamafio de la etiqueta es adecuado para el contenedor deseado.

6. Marque la casilla «<Multi-Part Label» (Etiqueta multicomponente) si es necesario
(véase a continuacion para mas informacion).

7 7 Seleccione el valor deseado en «Patient Role Applicability» (Aplicabilidad
de funcion de paciente). NOTA: debe seleccionarse al menos una de las funciones.
Véase a continuacion para mas informacion.

8. Repita los pasos anteriores para afiadir etiquetas adicionales segun las necesidades.

9. Haga clic en [¥] para guardar cualquier cambio o en < para cancelar.

NOTA:

* La casilla de seleccion «Multi-Part Label» (Etiqueta multicomponente) se utiliza para
contenedores que requieran dos partes (por ejemplo, una tapa y un contenedor).

Si esta casilla esta seleccionada, sera necesario escanear ambas etiquetas
consecutivamente durante una sesion de testigo. Una vez se ha guardado una etiqueta
como etiqueta multicomponente, la casilla de seleccion no puede modificarse.

= Todas las etiquetas deben estar vinculadas a al menos una Aplicabilidad de
funcion de paciente al afiadir una nueva etiqueta.

* Elcampo «Patient Role Applicability» (Aplicabilidad de funcién de paciente) garantiza
que se |mpr|ma la informacion de paciente correcta en la etiqueta. También garantiza
gue se imprime el nimero correcto de etiquetas para las funciones de paciente
en el ciclo. Por ejemplo, las etiquetas relacionadas solo con muestras de esperma
normalmente solo serian aplicables a la funcion «Partner/Sperm Donor» (Pareja/
Donante de esperma). No obstante, también se requeriria una etiqueta de archivo de
paciente normalmente para cada funcion de paciente en el ciclo.

= Etiquetas distintas no pueden tener el mismo nombre.

= Los codigos de barras de las etiquetas no pueden utilizarse para funciones de
seguimiento e identificacion en otros sistemas Gidget, por ejemplo, para transferir
una muestra de paciente de un laboratorio a otro.

» Una vez se ha afadido una etiqueta a la «<Label Library» (Biblioteca de etiquetas) y
se ha imprimido, ya solo podra editarse, pero no eliminarse.

3.2. Procedimientos

«Procedure» (Procedimiento) es el nombre otorgado a cada técnica realizada en el
laboratorio y normalmente se llevaran a cabo durante una Sesion de testigo, como OPU o
inseminacion. Una o mas etiquetas se agrupan para formar un Procedimiento y se utilizan
para garantizar que se imprimen las etiquetas correctas para el Paciente relevante.
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Procedimientos:
Los procedimientos deberan contener etiquetas apropiadas para las tareas especificas
que se realizan en el laboratorio (por ejemplo, OPU o inseminacion).

3.2.1. Anadir un Procedimiento

Para anadir un Procedimiento:

1. Haga clic en «Lab Process» (Proceso de laboratorio) en el menu desplegable
ubicado en la esquina superior derecha de la pantalla. Se muestra la pantalla «Lab
Process» (Proceso de laboratorio).

2. Haga clic en «2 Procedures» (2 Procedimientos) en la pantalla «Lab Process» (Proceso
de laboratorio). Se muestra la pantalla «Define Procedures» (Definir Procedimientos).

) | Admin =

o
<« B
Procedures Types + Label Library
Ics| Al Sperm And Rep And Spl .. BIOP
N
PGD BIOP Mo BM BM/FET Bo Wash CET
IVF
™M FREEZE Hatch 1 Hatch 2 Hyal
x ©
Al A\
THAW
csl ICSI Mo ICSI Sp [vFspm ] [nBM )

3. Hagaclic en +, en la parte superior de la columna «Procedure Types» (Tipos de
Procedimiento). Se muestra la pantalla «Define Procedure» (Definir Procedimiento).

4. Cree un nombre descriptivo para el Procedimiento (se recomienda un nombre
relacionado con el tipo de Procedimiento que esta creando, por ejemplo, IVF o
ICSI). NOTA: los nombres estan limitados a un maximo de 11 caracteres).

5. Si es necesario, seleccione un Procedimiento creado anteriormente desde el menu
desplegable «Copy From» (Copiar de). De esta manera, se copia un Procedimiento
existente que ahora podra asignar (por ejemplo, descongelado 1 o descongelado 2).

6. Haga clic en [¥) para guardar cualquier cambio o en < para cancelar.

3.2.2. Anadir etiquetas a un Procedimiento
Para anadir etiquetas a un Procedimiento:

1. Haga clic en «Lab Process» (Proceso de laboratorio) en el menu desplegable
ubicado en la esquina superior derecha de la pantalla. Se muestra la pantalla «Lab
Process» (Proceso de laboratorio).

2. Haga clic en «2 Procedures» (2 Procedimientos) en la pantalla «Lab Process» (Proceso
de laboratorio). Se muestra la pantalla «Define Procedures» (Definir Procedimientos).

3. Haga clic en el Procedimiento deseado de la columna «Procedure Types» (Tipos de
Procedimiento).

4. En la <Label Library» (Biblioteca de etiquetas), haga clic en las etiquetas que desee
incluir en el Procedimiento.
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5. Haga clic en [¥) para guardar cualquier cambio o en < para cancelar.
NOTA:

= Para seleccionar el numero de etiquetas impresas por defecto para un
procedimiento, =+ y — a la derecha del icono de etiqueta. El nimero se puede
establecer en cero para evitar la impresion de varias copias de esta etiqueta si
aparece varias veces en el mismo procedimiento o en procedimientos diferentes
en un ciclo. Por ejemplo, etiqueta de placa Geri.

= Para marcar una etiqueta como critica para el Procedimiento seleccionado, mueva
el cursor sobre la etiqueta deseada y seleccione Yy. Las etiquetas criticas se
indican con el icono *

= Las etiquetas criticas se utilizan dentro de un procedimiento para activar la
finalizacion del procedimiento en un dia de ciclo determinado. Durante los procesos
de laboratorio, una vez que se hayan escaneado todas las etiquetas criticas para un
Dia del Ciclo, la Tarjeta de Paciente relevante en la pantalla de Pacientes Activos
se mostrara como completa (verde con una marca). Esto permite una visibilidad
completa del progreso del paciente a lo largo del dia. Si un procedimiento no
contiene ninguna etiqueta critica, ese procedimiento se marcara como completo al
finalizar cualquier Sesion de Testigo al tocar @ el Escaner Portatil.

3.3. Tipos de Ciclo

Ciclos:

Al preparar la informacion de Ciclo para un paciente, debera especificar el Ciclo adecuado
que debe seguirse (por ejemplo, descongelado o IVF). Las opciones disponibles estaran
definidas por los Tipos de Ciclo que cree y deberian contener los Procedimientos
comunes para ese Tipo de Ciclo. Todas las etiquetas que no forman parte de un
Procedimiento (como una etiqueta de documentacion de paciente) también pueden
asignarse a un Tipo de Ciclo.

NOTA: Al preparar la informacién de ciclo para un paciente, tendra la opcion de incluir
juegos de etiquetas de Procedimiento adicionales ademas de las etiquetas definidas
en el Tipo de Ciclo. Las opciones disponibles seran las que se hayan definido en los
Procedimientos creados en la pantalla «Lab Process» (Proceso de laboratorio).

Para anadir un Tipo de Ciclo:

1. Haga clic en «Lab Process» (Proceso de laboratorio) en el menu desplegable
ubicado en la esquina superior derecha de la pantalla. Se muestra la pantalla «Lab
Process» (Proceso de laboratorio).

2. Haga clic en «3 Cycle Types» (3 Tipos de ciclo) en la pantalla «<Lab Process»
(Proceso de Iaboratoriogl. Se muestra la pantalla «Define Cycle Types» (Definir
Tipos de Ciclo).

3. Hagaclicen + enla parte superior de la columna «Cycle Types» (Tipos de Ciclo).
Se muestra la pantalla «Define Cycle Type» (Definir Tipo de Ciclo).

4. Cree un nombre descriptivo para el Tipo de Ciclo (se recomienda un nombre
relacionado con el tipo de Tipo de Ciclo que esta creando, por ejemplo, IVF o
descongelado).

5. Marque la casilla de seleccion «Involves Thaw Process» (Implica un proceso
de descongelado) si el Ciclo comienza con la descongelacion de un embrion.
Seleccionar esta casilla le permite especificar el dia de descongelado correcto al
preparar la informacion de Ciclo para un paciente.
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6. Sies necesario, seleccione un Tipo de Ciclo creado anteriormente desde el menu
desplegable «Copy From» (Copiar de). De esta manera, se copia un Tipo de Ciclo
existente que ahora podra asignar al nuevo Tipo de Ciclo.

7. Haga clic en [¥) para guardar cualquier cambio o en <« para cancelar.
) | Admin =

Cycle Types ¥ Labels Day 0 Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7

& ICsI/PGS Library Cycle Workflow

< IVF/PGS
Asst Hatch OPU

. Thaw/Warm ICSl insem SppCellizn
PGS IVF insem
Vit Gavi IVF m’over
Fert Check
ICSI m'over

Thaw

NOTA:
= Una vez se ha anadido un Tipo de Ciclo, ya solo podra editarse, pero no eliminarse.

* Una vez guardado un Tipo de Ciclo, la casilla «Involves Thaw Process» (Implica
proceso de descongelado) no puede modificarse.

3.3.1. Anadir procedimientos y etiquetas a un Ciclo
Para anadir procesos a un Ciclo:

1. Haga clic en «Lab Process» (Proceso de laboratorio) en el menu desplegable
ubicado en la esquina superior derecha de la pantalla. Se muestra la pantalla «Lab
Process» (Proceso de laboratorio).

2. Haga clic en «3 Cycle Types» (3 Tipos de ciclo) en la pantalla «<Lab Process»
(Proceso de laboratorio). Se muestra la pantalla «Define Cycle Types» (Definir
Tipos de Ciclo).

3. Haga clic en el Ciclo deseado de la columna «Cycle Types» (Tipos de Ciclo).

4. Seleccione el dia deseado en las pestafas.

5. Haga clic y mantenga pulsado para arrastrar los Procedimientos deseados de la
Biblioteca a la columna de ciclo donde los desea incluir.

6. Haga clic en [®] para guardar cualquier cambio o en ¢ para cancelar.
7. Repita este proceso para cada dia del ciclo.
Para anadir etiquetas a un ciclo:

8. Para marcar una etiqueta como critica para cada sesion de testigo, elija la pestafia
«Labels» (Etiquetas). Pase por encima de la etiqueta deseada y elija 1. Las
etiquetas criticas estan marcadas con x.
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NOTA:

* Para vincular Procedimientos, arrastre y suelte un Procedimiento sobre otro
Procedimiento. Al situar el cursor sobre el Procedimiento, se mostrara el icono €.
Para desvincular los Procedimientos, situe el cursor sobre la linea central de los
dos Procedimientos vinculados y seleccione @. Los procedimientos vinculados
se pueden escanear al mismo tiempo mediante distintos dispositivos escaner
portatiles sin que se desencadene una desviacion (por ejemplo, procedimientos de
preparacion de esperma y OPU).

» Para anadir un Procedimiento entre los Procedimientos existentes, arrastre un
Procedimiento de la Biblioteca y mueva el cursor sobre la posicién deseada en la
lista del Ciclo. Aparecera el icono @) para indicar el lugar en el que se ubicara el
Procedimiento cuando se suelte.

»  Un ciclo elejido como «Involves Thaw Process» (Implica proceso de descongelado) no
podra tener procedimientos programados ningun dia antes del dia de descongelado.

= Para reordenar los Procedimientos, arrastre los Procedimientos del flujo de trabajo
del Ciclo para situarlos en el orden deseado. Aparecera el icono @ para indicar el
lugar en el que se ubicaran los Procedimientos.

= Cualquier etiqueta que no haya sido seleccionada en ningun Procedimiento
estara disponible en la pestaria «Labels» (Etiquetas) para seleccionarla como una
etiqueta de “cada sesion testigo” (por ejemplo, etiquetas de papeleo).

= Cuando una etiqueta de “cada sesién de testigo” esté marcada como critica, no
aparecera en la lista de etiquetas criticas para ese procedimiento en el escéaner
portatil.

*  Elicono de estrella W se utiliza para marcar etiquetas o Procedimientos como criticos.

= Las Procedimientos criticos se utilizan para activar una advertencia y obtener
una respuesta de desviacion del usuario cuando se omiten. Cuando se selecciona
un Procedimiento diferente al siguiente Procedimiento previsto en el Dia de
Ciclo, aparecera una advertencia para indicar al usuario que se esta omitiendo un
Procedimiento. Si se trata de un Procedimiento critico, sera obligatorio introducir
una respuesta de desviacion en el Escaner portatil para poder continuar con la
Sesion de testigo. Si el Procedimiento omitido no estd marcado como critico,
se mostrara la advertencia pero no se requerira una respuesta de desviacion del
usuario. En ambos casos, el evento se registra en el informe del Historial del Ciclo

4. SEGUIMIENTO DE CONSUMIBLES

Gidget puede personalizarse para adaptarse a los procedimientos de laboratorio
individuales, al tiempo que realiza un seguimiento de los consumibles necesarios.

Para acceder a la pantalla Seguimiento de consumibles: haga clic en «Consumable
Tracking» (Seguimiento de consumibles) en el menu desplegable ubicado en la parte
superior derecha de la pantalla. Se muestra la pantalla Seguimiento de consumibles.

NOTA: Las fechas de caducidad de los consumibles introducidas en Gidget deben
utilizarse solo como una guia y no deben usarse para determinar la caducidad del
producto. Consulte directamente las fechas de caducidad proporcionadas por los
fabricantes del producto en el producto o en el embalaje del producto.

4.1. Tipos de Consumibles (Aplicacion web)

4.1.1. Anadir un tipo de consumible

Para afnadir un tipo de consumible:

1. Haga clic en «Consumible Tracking» (Rastreo de consumibles) en el menu
desplegable ubicado en la parte superior derecha de la pantalla. Se muestra la
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5.

6.

7.
NOTA:

41.2.

pantalla Seguimiento de consumibles.

Haga clic en + ubicado en la parte superior junto a la columna «Manufacturer»
(Fabricante). Se muestra la pantalla Definir tipo de consumible.

Cree un nombre descriptivo para el tipo de consumible (se recomienda que el
nombre se relacione con el tipo de consumible que esta creando, por ejemplo,
Medio de fertilizacion).

Seleccione «Media», «Plasticware» o «Ancillary» en el menu desplegable
«Category» (Categoria).

Ingrese el nombre del fabricante.

Ingrese el numero de catalogo.

Haga clic en B para guardar los cambios o para €= cancelar.

El numero de catalogo no es obligatorio

Eliminar un tipo de consumible

Para eliminar un tipo de consumible:

1.

Haga clic en «Consumible Tracking» en el menu desplegable ubicado en la
parte superior derecha de la pantalla. Se muestra la pantalla Seguimiento de
consumibles.

2. Localice el tipo de consumible deseado.
3. Desplace el cursor sobre el tipo de consumible deseado y haga clic cuando
aparezca.
4. Aparece la pantalla Seguimiento de consumibles y el tipo de consumible ya no esta
disponible.
NOTA: Solo se pueden eliminar los tipos de consumibles que no tengan un numero de lote
asociado.
4.1.3. Editar un tipo de consumible

Para editar un tipo de consumible:

1.

Haga clic en «Consumible Tracking» en el menu desplegable ubicado en la
parte superior derecha de la pantalla. Se muestra la pantalla Seguimiento de
consumibles.

Localice el tipo de consumible deseado.
. . . ]
Desplace el cursor sobre el tipo de consumible deseado y haga clic en # cuando
aparezca. Se muestra la pantalla Definir tipo de consumible.
Edite como desee.
Haga clic en B para guardar cualquier cambio o para €= cancelar.
Admin =
]
Name v Category v Manufacturer v + Lot# v Expires v Status v Active/Close v +

A Fertiedia Media Genea Biomedsx A 356 2018-11-15 Active 2018-11-19
Geri Dish Plasticware Genea Biomedx

A\ Oocyteretrieval buffer Media Genea Biomedx

988655 2018-12:07 Active 2018-11-08

654345 2021-01-07 In Storage

11-14
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NOTA: Solo se pueden editar los tipos de consumibles que no tengan un numero de lote
asociado.

4.2. Lotes Consumibles
4.2.1. Anadir un lote de consumibles (aplicacion web)

Para anadir un lote de consumibles:

1. Haga clic en Consumible Tracking en el menu desplegable ubicado en la
parte superior derecha de la pantalla. Se muestra la pantalla Seguimiento de
consumibles.

2. Haga clic en el tipo de consumible deseado de la columna «Consumable Type»
(Tipo de consumible) a la izquierda. (NOTA: cualquier lote activo o cerrado
existente se muestra en la columna «Consumable Lot» (Lote de consumibles) a la
derecha).

3. Hagaclicen + ubicado en la parte superior junto a la columna «Active/Close»
(Activo/Cerrar). Aparece la pantalla Definir lote de consumibles.

4. Cree un nombre descriptivo para el lote de consumibles. (NOTA: El nombre del
Consumible no se puede cambiar una vez guardado).

5. Ingrese el numero del lote de consumibles.
6. Seleccione la fecha de caducidad de los consumibles.
7. Haga clic para B guardar los cambios o para € cancelar.

4.2.2. Anadir un lote de consumibles (escaner portatil)

Para anadir un lote de consumibles;

1. Inicie sesion en el escaner portatil. Seleccione «Track consumibles» (Rastrear
consumibles) en el menu de la izquierda.

2. Escanee el codigo de barras del consumible que desee agregar.

3. Complete la informacién del numero de lote, tipo de consumible, fecha de
caducidad y estado

4.3. Activar un lote de consumibles (aplicacion web)
Para activar un lote de consumibles:

1. Haga clic en Consumible Tracking en el menu desplegable ubicado en la
parte superior derecha de la pantalla. Se muestra la pantalla Seguimiento de
consumibles.

2. Haga clic en el tipo de consumible deseado de la columna «Consumable Type»
(Tipo de consumible) a la izquierda.

jm)
3. Desplace el cursor sobre el lote de consumibles deseado y haga clic en =
cuando aparezca.

4. Haga clic en «Okay» (Aceptar) para activar el lote de consumibles o en «Cancel»
(Cancelar) para cancelar cualquier cambio. (NOTA: La fecha aparecera en la
columna «Active/Close» cuando se active el lote de consumibles).

4.3.1. Activar un lote de consumibles (escaner portatil)

Para activar un lote de consumibles:
1. nicie sesion en el escaner portatil. Seleccione Track consumibles en el menu de la
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izquierda.
2. Escanear el cédigo de barras del consumible.
3. Seleccione el lote a activar.

X Consumable Tracking

Manufacturer
Genea Biomedx

Lot #956123

Expiry Date 2019-03-14

Lot #461358
Expiry Date 2019-02-09

Lot #268347
Expiry Date 2019-01-17

Lot #268347
Expiry Date 2018-07-21

4. Arrastre el control deslizante para activar el lote y presione la marca para completar

4.3.2. Cerrar un lote de consumibles (solo aplicacion web)

Para cerrar un lote de consumibles:

1. Haga clic en Consumible Tracking en el menu desplegable ubicado en la
parte superior derecha de la pantalla. Se muestra la pantalla Seguimiento de
consumibles.

2. Haga clic en el tipo de consumible deseado de la columna «Consumable Type»
(Tipo de consumible) a la izquierda.

jm}
3. Desplace el cursor sobre el lote de consumibles deseado y haga clic en [
cuando aparezca.

4. Haga clic en «Okay» (Aceptar) para cerrar el lote de consumibles o en «Cancel»
(Cancelar) para cancelar cualquier cambio. (NOTA: La fecha aparecera en la
columna Active/Close cuando el lote de consumibles esté cerrado).

NOTA: Una vez cerrados, los lotes no pueden volver a abrirse.

4.3.3. Editar un lote de consumibles (aplicacién web)

Para editar un lote de consumibles:

1. Haga clic en Consumible Tracking en el menu desplegable ubicado en la
parte superior derecha de la pantalla. Se muestra la pantalla Seguimiento de
consumibles.

2. Haga clic en el tipo de consumible deseado de la columna «Consumable Type»
(Tipo de consumible) a la izquierda.

. . O
3. Desplace el cursor sobre el lote de consumibles deseado y haga clic # cuando
aparezca. Aparece la pantalla Definir lote de consumibles.

4. Edite como desee.
5. Hagaclic en = para guardar cualquier cambio o para € cancelar.
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4.3.4. Editar un lote de consumibles (escaner portatil)
Para editar un lote de consumibles:

1. Inicie sesién en la computadora de mano. Seleccione Track Consumable en el
menu de la izquierda:

2. Escanee los consumibles a editar
Seleccione el consumible en la lista.

4. Realice los cambios necesarios y presione la marca para completar.

4.3.5. Vincular un consumible a una placa de ciclo del paciente. (solo escaner
portatil)

Los consumibles se pueden vincular directamente mediante el escaneo a las placas de
uno o mas ciclos de pacientes. Para vincular un consumible a un ciclo de paciente;

1. Inicie sesion en el escaner portatil. Seleccione «Track Consumibles» (Rastrear
consumibles) en el menu de la izquierda.

2. Escanee los consumibles a vincular.
3. Seleccione el lote a vincular (active si es necesario).
4. Escanee una etiqueta del ciclo del paciente para vincular. (NOTA: se pueden

escanear multiples etiquetas de pacientes si se preparan muchas placas de
pacientes al mismo tiempo).

NOTA: La vinculacion de consumibles directamente a las placas de los pacientes se puede
utilizar cuando se abren multiples lotes de un consumible el mismo dia.

NOTA:

- Se mostrara un simbolo & cuando un lote de consumibles haya caducado.

= Aparecera un simbolo A\ cuando un lote de consumibles expire en 9 dias o
menos.

= Solo se pueden editar los lotes de consumibles que no estén activos actualmente.
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5. FUNCIONAMIENTO BASICO: APLICACION
WEB

Para acceder a la aplicacion web Gidget:
1. Abra el navegador Google Chrome (versiéon 51 o posterior).

2. Introduzca la direccion IP del CCS en la barra de direcciones del navegador
y pulse Intro (NOTA: el administrador de laboratorio o el administrador de Tl
especifica la direccion IP en la lista de comprobacion de preinstalacion).

3. Se visualizara la pagina de inicio de sesion.

5.1. Inicio de sesion
Para iniciar sesion: introduzca su Nombre de usuario y su PIN en la pantalla de inicio de
sesion de Gidget. Se muestra la pantalla «Active Patients» (Pacientes activos).

NOTA:
= Se necesita un Nombre de usuario y un PIN para iniciar sesion en la aplicacion web.
= Siseintroduce un PIN incorrectamente tres veces seguidas el usuario quedara

bloqueado sin acceso a Gidget. Si esto ocurre, hable con su supervisor o
administrador de laboratorio. (véase “2.4. Reactivar un usuario” en la pagina 8)

5.2. Pantalla de Pacientes activos

La pantalla «Active Patients» (Pacientes activos) es la pantalla principal de Gidget, y ofrece
un resumen de todos los Propietarios/Pacientes que tienen actualmente un Ciclo activo,
junto con la informacién del estado de su ciclo.

Lastname, First Lastname, First Lastname, First
123456789 1zsTEs 123456789 123456789
W 23456709011 V12056785011 VF 123456785011 W 1234678011
Lastname, First Lastname, First
123156789 1234567

R 1234680011 1 v vl v
Lastname, First

2367
Vsl v

Lastname,
1234567

1234567
VEMsTs0LL W \sTesold
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@ Logotipo de Genea

Al hacer clic en el logotipo de Genea desde cualquier pantalla volvera directamente a la
pantalla «Active Patients» (Pacientes Activos).

@ «Incoming» (Entrantes)

La columna «Incoming» (Entrantes) contiene todos los pacientes programados para
comenzar con el Dia 0 en el dia laboral actual, ademas de las horas de sus citas. Para un
paciente entrante, el Dia O comenzara cuando se complete su primera Sesién de testigo.
Su tarjeta se movera entonces de la columna de entrantes a la columna «Day 0» (Dia 0).

@ Error critico

Los errores criticos aparecen resaltados en rojo tanto en la Tarjeta de paciente como
en el Indicador del estado de progreso correspondiente. Los errores criticos deben ser
resueltos por el supervisor o el administrador del laboratorio para poder proseguir con
cualquier proceso de Gidget adicional.

@ Indicadores del estado de progreso

Estos indicadores muestran cuantos ciclos requieren tareas adicionales del Dia de ciclo en
el dia laboral actual.

@ Tarjetas de paciente en gris

Una Tarjeta de paciente en gris indica que no se han escaneado todas las etiquetas
criticas para el Dia de ciclo de ese paciente. La pantalla «Active Patients» (Pacientes
Activos) permite comprobar facilmente si se han completado todas las tareas necesarias
para el Dia de ciclo actual. Al final del dia laboral, todas las tarjetas mostradas deben estar
en verde si se han escaneado todas las etiquetas criticas. A las 00:00 (medianoche), las
Tarjetas de paciente pasan automaticamente al siguiente Dia de ciclo y apareceran en gris.
Todos los ciclos sin Procedimientos planificados para ese Dia de ciclo apareceran como
completados (verde con sefal de aprobacion).

@ Incompatibilidad
Error de correspondencia del paciente

Un error de correspondencia de paciente es un error critico que se produce si se
escanean dos etiquetas de paciente no vinculadas durante la misma Sesion de testigo. La
Tarjeta de paciente relevante se resaltara en color rojo y se colocara en la parte superior
de la lista. Estos errores deben ser resueltos por el supervisor o el administrador del
laboratorio para poder proseguir con cualquier proceso de Gidget adicional.

Error de correspondencia de la muestra

Un error de correspondencia de la muestra es un error critico que se produce cuando una
etiqueta de un ciclo previo se escanea y la etiqueta no ha sido vinculada al ciclo activo. La
Tarjeta de paciente relevante se resaltara en color rojo y se colocara en la parte superior
de la lista. Estos errores deben ser resueltos por el supervisor o el administrador del
laboratorio para poder proseguir con cualquier proceso de Gidget adicional.

@ Tarjetas de paciente en verde

Una Tarjeta de paciente en verde indica que se han completado todas las tareas
requeridas para el Dia de ciclo de ese paciente.
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NOTA: La barra superior «Cycles Remaining» (Ciclos restantes) muestra los Ciclos
restantes en la Licencia actual. Una vez guardada la Informacion de ciclo del paciente,

el numero de Ciclos restantes en su Licencia actual se reduce en 1 o0 en 0,5 en funcién
del valor del Ciclo. Si se cancela un Ciclo sin testigo de una sesion, el numero de Ciclos
restantes en su Licencia actual recupera 1 0 0,5 en funcion del valor del Ciclo. Esta
informacion puede consultarse en las pantallas «Active Patients» (Pacientes Activos) y
«Licenses» (Licencias).

5.3. Preparacion de la informacion de Ciclo de paciente
Antes de comenzar los procesos clinicos para un Ciclo de paciente, debe introducir

la informacion sobre el Ciclo. Durante la preparacion del Ciclo, debera especificar las
Funciones de paciente para el Ciclo, ademas de especificar cualquier paciente adicional
vinculado al Ciclo y sus respectivas funciones (por ejemplo, «Partner», «Sperm Donor»,
«Oocyte Donor» y «Surrogate» [Pareja, Donante de esperma, Donante de ovocito

y Subrogado]). También debera especificar qué Ciclo y qué Procedimientos seran
necesarios para garantizar que imprime las etiquetas adecuadas.

NOTA:
= Los pacientes solo se vinculan mientras dure el Ciclo.
= Solo es posible seleccionar una funcion para los donantes sin receptora asignada.

5.3.1. Vincular pacientes en un Ciclo
Para vincular pacientes:

1. Haga clic en «Active Patients» (Pacientes activos) en el menu desplegable ubicado
en la esquina superior derecha de la pantalla. Se muestra la pantalla «Active
Patients» (Pacientes activos).

2. Haga clic en €}, en la esquina superior derecha de la pantalla. Se muestra el Paso
1 de la pantalla «Prepare Cycle Information» (Preparar informacion del ciclo).

3. Introduzca el nombre o el numero del paciente en la caja de busqueda deseada
y seleccione el paciente deseado del campo de busqueda autocompletado. Se
mostrara la informacion del paciente. Si el nombre o numero del paciente no
aparece en el cuadro de busqueda de autocompletar, haga clic en «Create New
Patient» (Crear nuevo paciente) y agregue los detalles del paciente segun sea
necesario.

4. Revise la informacion para asegurarse de que es correcta.

5. Introduzca el nombre o el numero del paciente o pacientes que se va a vincular al
Propietario del ciclo en el campo «Patient Role» (Funcion de paciente) deseado
(«Partner/Sperm Donor», «Oocyte Donor» y «Surrogate» [Pareja/Donante de
esperma, Donante de ovocito y Subrogado]).

6. Introduzca el nombre o el niumero del paciente para cualquier «Patient Role»
(Funcion del paciente) vinculada restante.

7. Haga clic en ubicada en la parte superior derecha de la pantalla. Se mostrara el
paso 2 en la pantalla «Prepare Cycle Information» (Preparar informacion del ciclo).

NOTA: Al seleccionar «Create New Patient» (Crear nuevo paciente), el usuario puede
seleccionar la opcion «Anonymous Donor» (Donante anonimo).. La casilla <Anonymous
Donor» (Donante anonimo) no esta disponible para la funcion «Surrogate» (Subrogado).

5.3.2. Vincular muestras en un Ciclo

Las muestras, como los embriones o gametos previamente almacenados, pueden
vincularse a un ciclo para permitir que sean observados como parte de ese nuevo ciclo,
por ejemplo, para los ciclos de descongelacion.
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Para vincular una muestra:

1. En «Prepare Cycle» (Preparar ciclo), Paso 1, navegue para completar el ciclo de
la tabla de enlaces debajo de la informacién del paciente para la tarea deseado.
Seleccione el contenedor y la fecha de congelacion a la que pertenece la muestra
vinculada y seleccione la casilla de verificaciéon para vincularlo.

2. Marque la casilla de verificacion «Link to all cycles» (Vincular a todos los ciclos) si
las etiquetas de todos los ciclos completados, incluidos los ciclos anteriores para
el mismo paciente, se escanearan durante este ciclo recién creado.

) | Admin =

<« >

Step 1 - patients

Owner Thompson, Anna, 1234456, 1981-09-22

*Last Name Thompson Address 12, Something way
* First Name Anna
* Patient # 1234456 Phone +61 123 456789
*DOB 1981-09-22
* Gender Female
Anonymous donor

Link to all cycles

Cycle# Cycle Type Scans Commenced On

1234567890 IVF 2018-09-22

Container Freeze Date Sample #

OocyteVit

2018-09-22 #1

<]

2018-12-27 #2

<]

#5

<]

#8

0123456789 Thaw 2018-10-30

an12248670 Cre n19.11.08

NOTA:

= Para vincular las muestras a un ciclo programado o activo para, por ejemplo, vincular
embriones adicionales en caso de una descongelacion fallida, vaya a «Review
Patient» (Revisar paciente), seleccione «Linked Cycles» (Ciclos vinculados) y, a
continuacion, pulse + para vincular nuevos ciclos siguiendo los pasos anteriores.

*  No es posible vincular una muestra desde un ciclo activo (por ejemplo, vincular una muestra
desde un ciclo de congelacion de esperma cuando este ciclo aun no ha finalizado).
5.3.3. Crear ciclos de pacientes simultaneos
En la lista de pacientes, el icono de creacion de ciclo no estara disponible para aquellos
pacientes que ya formen parte de un ciclo programado o activo. Para crear ciclos simultaneos;
1. Seleccione €} en la pantalla «Active Patients» (Pacientes activos)

2. Escriba los 3 primeros caracteres del apellido del paciente y seleccione el paciente
de la lista desplegable. El simbolo @ indicara los pacientes con ciclos simultaneos.

3. Complete los detalles del paciente y la vinculacién para este ciclo.
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5.3.4. Detalles del ciclo

1. Ingrese el nimero de ciclo deseado. (NOTA: el sufijo del numero de ciclo se
completara previamente para cualquier ciclo simultaneo que se cree. Este campo
de entrada se puede editar hasta el primer escaneo de etiquetas).

2. Especifique el tipo de ciclo en el menu desplegable (NOTA: si el tipo de ciclo
seleccionado comienza con un proceso de descongelacién, aparecera un campo
adicional que permitira especificar el dia de descongelacién. Si no se enumeran los
tipos de ciclos, consulte a su supervisor de laboratorio o administrador ).

3. Especifique la Fecha de inicio en laboratorio (afio-mes-dia). NOTE: esto se refiere
a la fecha en que los procesos comienzan dentro del laboratorio.

4. Toque la pestafia de cada dia para verificar los procedimientos programados para
ese ciclo. Si se requiere un procedimiento adicional para un dia en particular,
seleccione @ para agregar y seleccionelo en el menu desplegable. (NOTA: Los
procedimientos agregados seran criticos de manera predeterminada y se pueden
eliminar hasta el escaneo de la primera etiqueta).

5. Especifique la hora del procedimiento (la hora se muestra en tiempo de 24 horas).
(NOTA: este campo no aparecera si el tipo de ciclo seleccionado implica un
proceso de descongelacion).

6. Haga clic en = ubicado en la parte superior derecha de la pantalla. Aparece una
pantalla de resumen.

7. Asegurese de que toda la informacion es correcta.

8. Haga clic en [ para guardar cualquier cambio o en para < volver a alguno de los
pasos anteriores..

9. Haga clic en @ para imprimir etiquetas para el Ciclo de paciente actual.

Una vez guardados todos los cambios, el Propietario y todos los pacientes vinculados
apareceran en la pantalla «Active Patients» (Pacientes activos) con el campo «Stage»
(Etapa) con el valor «Scheduled» (Programado). En la fecha de inicio del Ciclo del
paciente, la Etapa cambiara a «Incoming» (Entrante).

NOTA: Una vez guardada la Informacion de ciclo del paciente, el numero de Licencias
actual se reduce en 1 o0 0,5 en funcion del valor del Ciclo. Si se cancela un Ciclo sin
testigo de una sesion, el numero de Licencias restantes recupera 1 o 0,5 en funcion del
valor del Ciclo (véase «Cancelar un Ciclo»).

5.4. Imprimir etiquetas para un Ciclo preparado
Para imprimir etiquetas:
1. Haga clic en «Patient List» (Lista de pacientes) en el menu desplegable ubicado
en la esquina superior derecha de la pantalla. Se muestra la pantalla «Patient List»
(Lista de pacientes).
2. Situe el cursor sobre el nombre del paciente deseado y haga clic en &=
cuando aparezca. Aparece la pantalla «Print Labels» (Imprimir etiquetas), que
muestra todas las etiquetas asociadas con el Ciclo especificado, agrupadas en
Procedimientos y por dia.
3. Seleccione si va a imprimir todos o un tipo de repertorio de etiquetas mediante el
menu desplegable.

4. Seleccione la impresora o impresoras deseadas mediante los menus desplegables.

5. Haga clic en las etiquetas deseadas para resaltarlas y seleccionarlas, o utilice
la opcion «Select All» (Seleccionar todas). (NOTA: Para seleccionar el nimero
requerido de cada etiqueta (para multiples etiquetas), desplace la etiqueta
deseada y utilice y para seleccionar el numero deseado. El nimero solo aparecera
en la etiqueta si es mayor que uno. Una etiqueta aun esta asociada con el
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procedimiento cuando el niumero de etiquetas para imprimir se establece en 0).
6. Haga clic en #® en la esquina superior derecha de la pantalla.

NOTA: Si se imprimen etiquetas de “nivel de muestra”, aparecera un cuadro

de dialogo que solicita al usuario que seleccione el numero de articulo de las
etiquetas. Por ejemplo, si las etiquetas para los embriones 1, 2, 3,4, 9y 12 se estan
imprimiendo, el usuario escribiria 1-4, 9, 12. El nUmero maximo de muestra es 99.

Print Sample Number Labels

Select sample numbers to print:

|

X Cancel Print  omm

7. Fije las etiquetas en los contenedores y archivos/documentos correspondientes.

NOTA:
» Las etiquetas de contenedores que aparecen en multiples Procedimientos (p.
ej., Placa Geri) se copiaran varias veces por defecto. Deseleccione las copias en
Procesos/Procedimientos de laboratorio segun sea necesario. La designacion de
criticidad permanecera en las etiquetas seleccionadas como copias cero.
= Las etiquetas Wrap-around se imprimiran con un cédigo de barras 1D y son unicas
en el conjunto de bases de datos de Gidget.

* Elicono & indica una impresora por defecto.

5.5. Completar ciclos

Cuando se han completado todas las Sesiones de testigo relevantes para un Ciclo de
paciente, el ciclo debe registrarse como completado.

Para registrar un Ciclo de paciente como completado:
1. Haga clic en la Tarjeta de paciente deseada de la pantalla «Active Patients»
(Pacientes activos). Aparece la pantalla «Review Patient» (Revisar paciente), que
muestra informacion detallada del paciente seleccionado.

2. Cambie de pestaria para revisar los detalles del paciente, los detalles del ciclo,
los ciclos vinculados y los pacientes vinculados y asegurese de que se han
completado todas las Sesiones de testigo para el Ciclo del paciente.

3. Haga clic en /, en la esquina superior derecha de la pantalla para registrar el
Ciclo como completado.

4. Haga clic en aceptar para confirmar o en cancelar para cancelar los cambios
(NQTA: una vez se ha registrado el Ciclo como completado ya no es posible
deshacer la operacion).

Una vez se ha registrado el Ciclo de paciente como completado, ese Ciclo ya no
aparecera en la pantalla «Active Patients» (Pacientes activos), y todos los pacientes
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vinculados a ese Ciclo quedaran desvinculados. En la pantalla «Patient List» (Lista de
pacientes), su Etapa aparecera como «None» (Ninguna).

5.6. Pantalla de Lista de pacientes

Para acceder a la pantalla «Patient List» (Lista de pacientes): Haga clic en «Patient
List» (Lista de pacientes) en el menu desplegable ubicado en la esquina superior derecha
de la pantalla. Se muestra la pantalla «Patient List» (Lista de pacientes).

«Licenses Remaining» (Licencias restantes): muestra las licencias restantes. Una vez
guardada la Informacion de ciclo del paciente, el numero de Licencias restantes se reduce
en 1 o en 0,5 en funcion del valor del Ciclo. Si se cancela un Ciclo sin testigo de una
sesion, el numero de licencias restantes aumenta 1 o 0,5 en funcion del valor del Ciclo..
Esta informacion puede consultarse en las pantallas «Active Patients» (Pacientes Activos)
y «Licenses» (Licencias).

«Stage» (Etapa): indica el estado del Ciclo para cada paciente (NOTA: esto afecta a
todos los pacientes vinculados en un Ciclo).

» «None» (Ninguna): indica que el paciente no tiene Informacion de ciclo preparada
o un Ciclo activo, y no esta vinculado a ningun otro paciente.

» «Scheduled» (Programado): indica que el paciente tiene Informacion de ciclo
preparada y una fecha de inicio programada para comenzar sus procesos de laboratorio.

» «Incoming» (Entrante): indica que los procesos de laboratorio del paciente tienen
programado su inicio en el dia laboral actual.

» «Day 0-7» (Dia 0-7): muestra el Dia de ciclo actual para todos los Pacientes activos.

NOTA: Hay disponible un filtro de busqueda para encontrar rapidamente a pacientes por
su nombre, apellido o numero de paciente.

5.6.1. Modificar o revisar informacion de ciclo de paciente

PRECAUCION: Sera necesario volver a imprimir las etiquetas si se cambia la informacion del
paciente, y podria ser necesario volver a imprimirlas si se afade un Procedimiento a un Ciclo.
Asegurese de que las etiquetas afectadas por los cambios en un Ciclo activo y que ya se hayan
imprimido se reemplacen con las nuevas etiquetas imprimidas después de realizar cambios.

NOTA:

= LalInformacion de ciclo solo se puede modificar si el Ciclo de paciente no esta activo.

= Siun Ciclo de paciente ya esta activo, es posible afadir o eliminar procedimientos
adicionales.

= Sialguna informacion adicional requiere una actualizacion en un Ciclo activo, sera
necesario cancelar el Ciclo.

= LaInformacion de paciente de un Ciclo activo también puede revisarse
directamente desde la pantalla «Active Patients» (Pacientes activos) haciendo
clic en la Tarjeta de paciente relevante. También se pueden vincular muestras
adicionales 8por ejemplo, embriones o0 gametos) a un ciclo activo.

Para modificar o revisar Informacioén de ciclo:

1. Haga clic en «Patient List» (Lista de pacientes) en el menu desplegable ubicado
en la esquina superior derecha de la pantalla. Se muestra la pantalla «Patient List»
(Lista de pacientes).

2. Siome el cursor sobre el nombre del paciente deseado para resaltarlo y haga clic en
#° cuando aparezca. Se muestra la pantalla «<Review Patient» (Revisar paciente).

3. Actualice la informacién necesaria.
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4. Haga clic en [¥] para guardar cualquier cambio o en & para cancelar.
Admin =

B

n
e

Owner Thompson, Anna, 1234456, 1981-09-22 Cycle # I 159263478-1 I

Patient Details Cycle Details Linked Cycles Linked Patients Transfer Samples

Cycle Type Warm/Thaw

Cycle # 159263478 -1
Laboratory Start Date 2019-03-26
Day 0 Day 1 Day 2 Day 3 Day 4 Day 5 Day 6 Day 7 +
v

Warm

Emb Transfer

NOTE: Introduzca el nombre o la ID del paciente en el campo de busqueda situado en la
parte superior de la pantalla «Patient List» (Lista de pacientes) para encontrar rapidamente

al paciente indicado.
5.6.2. Transporte de muestras con la configuracion del Cédigo Unico Eu-

ropeo (SEC)
Gidget permite la impresién de etiquetas que cumplen con los requisitos de etiquetado del
SEC. Para imprimir etiquetas SEC;

1. Haga clic en «Patient List» (Lista de pacientes) en el menu desplegable ubicado en
la parte superior derecha de la pantalla. Se muestra la lista de pacientes.

2. Localice el paciente deseado y haga clic en ¢ para entrar en «Review Patient»
(Revisar paciente)

) | Admin =
Owner Thompson, Anna, 1234456, 1981-09-22 Cycle # 159263478-1
Patient Details Cycle Details Linked Cycles Linked Patients Transfer Samples
Single European Code Printer @& Office Brady v
Coding
Country TE Unique System Product Expiry -
Identifier Code Donation # Identifier Code Split # Date =
BE 00A317 0000000235982 E 0000068 001 20190126 + 0
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Seleccione la pestana «Transport Samples» (Muestras de transporte). (NOTA: Si
esta pestana no esta presente, vaya a Configuracion y complete los campos bajo
el Codigo Unico Europeo).

Complete los campos de impresion de acuerdo con los requisitos del SEC

Seleccione «Printer» (Impresora) en la lista desplegable y haga clic en (icono de
impresion) para imprimir.

Las etiquetas siempre se imprimiran por duplicado para el dispositivo y el papeleo
de transporte.

Las etiquetas SEC solo se imprimen en formato de etiqueta Wrap-around.

5.7. Cancelar ciclos
Si es necesario, es posible cancelar un Ciclo preparado que aun no esté activo.

Para cancelar un Ciclo:

1.

Haga clic en «Patient List» (Lista de pacientes) en el menu desplegable ubicado
en la esquina superior derecha de la pantalla. Se muestra la pantalla «Patient List»
(Lista de pacientes).

Localice al paciente deseado.

Desplace el cursor sobre el paciente deseado y haga clic en #° cuando aparezca.
Se muestra la pantalla <Review Patient» (Revisar paciente).

Haga clic en X, en la esquina superior derecha de la pantalla para cancelar el Ciclo.
Haga clic en aceptar para confirmar o en cancelar para cancelar los cambios.

No es posible cancelar un Ciclo activo. Debe ajustarse su estado a completado
para eliminarlos de la pantalla «Active Patients» (Pacientes activos).

Toda etiqueta imprimida para un Ciclo cancelado debe desecharse.

Cualquier ciclo guardado cancelado antes de comenzar seguira “consumiendo”
el numero de ciclo. Sin embargo, ese numero de ciclo se puede reutilizar con un
sufijo de ciclo distinto.

5.8. Mi configuracién de usuario

Los usuarios individuales pueden actualizar o modificar su Nombre, su PIN y su direccion
de correo electronico.

Para editar la configuracion de usuario:

1.

2.
3.

Haga clic en «My User Settings» (Mi configuracién de usuario) en el menu
desplegable ubicado en la esquina superior derecha de la pantalla. Se muestra la
pantalla <My User Settings» (Mi configuracion de usuario).

Modifique la informacion deseada.
Haga clic en [5) para guardar cualquier cambio o en & para cancelar.

5.9. Informes

Informar permite visualizar y exportar Informes. Los informes contienen un registro
completo de las actividades realizadas con el Escaner portatil Gidget, incluidos todos los
errores, advertencias y sesiones incompletas.
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5.9.1. Visualizar o exportar un Informe
Para exportar un Informe:

1. Haga clic en «Reporting» (Informar) en el menu desplegable ubicado en la esquina
superior derecha de la pantalla. Se mostrara la pantalla «Reporting» (Informar).

2. Seleccione «Cycle History» (Historial de ciclo), «Witness Session» (Sesion de testigo) o
«Consumable» (Consumible) en el menu desplegable «Report Type» (Tipo de informe).

Admin =
(©

Report type

Cycle history v

Witness session

Consumable

Filters

Patient

All I Only show workflow deviations

Start Date

2019-01-17 I

End Date

2019-03-26 I

Anonymous

Hide anonymous patients v l

3. Silo desea, especifique filtros para el Informe de auditoria:

Seleccione el intervalo de «Start Date» (Fecha de inicio) y «<End Date» (Fecha
de finalizacion) deseado (el intervalo maximo seleccionable es tres meses y
el sistema ajustara por defecto un periodo de tres meses antes de la fecha
actual. Para periodos de tiempo mas prolongados, cree multiples auditorias)

Introduzca el nombre o el numero del paciente deseado en la casilla
«Patient» (Paciente).

Seleccione el Nombre de usuario deseado con el menu desplegable «User
Name» (Nombre de usuario).

Seleccione el estado anonimo deseado en el menu desplegable
«Anonymous» (Anénimo). NOTA: La informacion principal del paciente
siempre se muestra en el informe. Los otros pacientes pueden anonimizarse
en funcion de: 1. Mostrar pacientes anonimos: el paciente subyacente se
muestra en todos los campos relevantes del informe. 2. Ocultar pacientes
anonimos: los nombres de los pacientes andnimos se enmascararan con el
nombre del propietario del ciclo, pero se conservara el nimero de paciente
del paciente anonimo. 3. Ocultar pacientes no primarios: los pacientes

no primarios seran enmascarados por el nombre del paciente primario
(Propietario y Donantes de unica tarea) que muestra solo el niumero del
paciente. Esta funcion se puede utilizar para enmascarar a los pacientes que
no se han anonimizado durante la preparacién del ciclo, pero de los cuales
luego el laboratorio requiere la anonimizacion en el informe.

Seleccione los filtros deseados con las casillas de seleccion «Filter» (Filtro).

4, Haga clic en Q, en la esquina superior derecha de la pantalla. Se muestra la
pantalla «<Search Results» (Resultados de busqueda).
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NOTA:
= En una Auditoria de Sesion de testigo cada linea de la pagina de resultados de
busqueda representa una Sesion de testigo. Al hacer clic en una linea apareceran
los escaneados individuales de esa Sesién de testigo.

* En el Historial de auditoria del Ciclo cada linea representa un evento (p. €j.,
Procedimientos omitidos, afiadidos o perdidos).

5. Haga clic en |1, en la esquina superior derecha de la pantalla, para exportar el
Informe o en & para regresar a la pantalla «Reporting» (Informar). (NOTA: Los
informes de «Witness Session» (Sesion testigo) y «Cycle History» (Historial de ciclo)
se exportan como PDF. Los informes de consumibles se pueden exportar como CSV
o PDF. Para exportar un informe de consumibles como CSV o PDF, seleccione el tipo
de archivo deseado en el menu que se muestra cuando se hace clic en el botén de
exportar).

Los Informes se exportan como PDF y se guardan automaticamente en la ubicacion
especificada en el navegador web de su laboratorio. Si es necesario, consulte el manual de
usuario de su navegador o hable con su supervisor o administrador de laboratorio.
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6. FUNCIONAMIENTO BASICO DEL ESCANER

6.1. Descripcidn

El Escaner portatil Gidget consiste en un iPod touch® de Apple y una base de escaneado
Linea Pro 5®. El escaner se utiliza para escanear etiquetas durante las Sesiones de
testigo de un Dia de ciclo.

NOTA:
= El escéaner cerrara su sesion tras 120 segundos de inactividad, y tendra que volver
a iniciar sesion.
= Una vez iniciada una Sesion de testigo, el escaner cerrara su sesion tras 60
segundos de inactividad.

= Se recomienda inhabilitar la funcion de bloqueo automatico del iPod (vaya a
Ajustes > Pantalla y Brillo > Bloqueo automatico, y seleccione Nunca).

Botén de encendido
del escaner

Ventana del escaner

Boton de inicio
de escaneado

Base x

Puerto de carga J

6.1.1. Almacenamiento

Asegurese de que el escaner siempre se almacena en las Estaciones de carga de Gidget
proporcionadas.

iPod touch®

6.1.2. Limpieza y mantenimiento

Debe prestarse atencién para evitar tocar o rayar la ventana del escaner, ya que esto
podria afectar al funcionamiento del escaner. Si es necesario, puede limpiarse la ventana
del escaner utilizando un pafio o tejido y un limpiador especificos para lentes.

Para la desinfeccion de la pantalla y el escaner, aplique una solucion de alcohol Para la
desinfeccion de la pantalla y el escaner, aplique una solucion de alcohol isopropilico al 70
% a un tejido o pafio no abrasivo y limpie suavemente las areas afectadas. Es importante
utilizar un pafo que solo esté humedecido y no mojar la pantalla ni dejar marcas de gotas.

Para mas informacion sobre la limpieza y el mantenimiento, consulte la documentacion
relevante del fabricante entregada durante la instalacion del sistema Gidget.

El estado de carga se indica mediante la barra de carga en la parte superior derecha de la
pantalla del iPod. Una unidad de escaner portatil normalmente durard 10 horas con el uso
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normal de laboratorio. Siga las instrucciones del fabricante para obtener informacién sobre
el mantenimiento de la bateria.

NOTA: Para utilizar productos con compuestos organicos volatiles (COV), aplique los
procedimientos normalizados de trabajo del laboratorio.

6.2. Inicio de sesion

Para iniciar sesion en el Escaner portatil Gidget necesitara su ID de usuario o su Nombre
de usuario, y su PIN.

Para iniciar sesion:

1. Retire el escaner de la estacion de carga.

2. Pulse el botdn de inicio del iPod para encender el escaner. Evite utilizar el boton
de encendido del escaner, ya que esto podria afectar a la comunicacion con el
sistema de computacion central de Gidget (CCS).

3. Deslice para desbloquear. Se muestra la pantalla de inicio del iPod.
Pulse . Se mostrara la pantalla «Login» (Inicio de sesion).

5. Escanee el codigo de barras de su ID de usuario o introduzca su Nombre de
usuario y pulse «Go» (Continuar).

6. Introduzca su PIN.

B

Ya ha iniciado sesion y se muestra la pantalla «Active Patients» (Pacientes activos) del escaner.

NOTA: SiSi es la primera vez que se inicia sesion en el dispositivo, se solicitara que un
ingeniero de servicio introduzca un cédigo de configuracién y direccion IP.

6.3. Sesiones de testigo

Una Sesiodn de testigo se utiliza en situaciones que normalmente requeririan la presencia
de una segunda persona que actue como testigo de una tarea. Una Sesion de testigo

se realiza escaneando todas las etiquetas asociadas a una tarea. Gidget comprobara
activamente cualquier norma de flujo de trabajo que su laboratorio haya establecido y
verificara que todas las etiquetas escaneadas se correspondan con el paciente o con los
pacientes vinculados dentro de un Ciclo.

6.3.1. Realizar una Sesion de testigo

NOTA:

= Durante una Sesion de testigo, el escaner cerrara su sesion automaticamente tras
60 segundos de inactividad.

= Se recomienda especialmente realizar la Sesién de testigo antes de comenzar
cualquier otra tarea.

= Prepare y recoja todos los materiales relevantes para completar las tareas de Ciclo
pertinentes, como los contenedores y los archivos de paciente.

= Asegurese de que todas las etiquetas estan fijadas a sus contenedores y archivos
relevantes para la sesion de testigo.

= Sino es posible escanear el codigo de barras de la etiqueta, se puede realizar el
proceso de testigo para la etiqueta (véase «Testigo manual de etiquetas» mas adelante).

= Al escanear etiquetas transparentes a través de medios evite la caida de gotas
directamente sobre el cédigo de barras, ya que esto podria impedir el escaneado.
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= Las etiquetas transparentes pueden escanearse correctamente desde ambas direcciones.
= No hay limite al nimero de veces que puede realizar una Sesién de testigo.

Para realizar una Sesién de testigo:

1. Escanee cualquiera de los codigos de barras de etiqueta del paciente. La Sesion
de testigo comienza y se muestra una lista de Procedimientos que contienen
esta etiqueta, con el proximo Procedimiento logico resaltado en color azul. La
informacion del paciente aparece junto con la informacion relacionada con el cédigo
de barras de etiqueta escaneado (por ejemplo, tipo de archivo o contenedor). Si
solo hay un procedimiento para realizar ese dia, se seleccionara automaticamente.

2. Siga escaneando todas las etiquetas asociadas a la Sesion de testigo.

3. Cuando haya escaneado todas las etiquetas, pulse ° para registrar la Sesion de
testigo. Se muestra la pantalla «Active Patients» (Pacientes activos).

= Se puede iniciar una sesién de testigo escaneando la etiqueta del paciente desde
la pantalla de pacientes activos, la pantalla de sesion de testigo y la pantalla del
historial del paciente.

= Las desviaciones del flujo de trabajo, incluidas las omisiones de Procedimientos
y los Procedimientos incompletos, iniciar un Procedimiento omitido, iniciar un
Procedimiento completado o iniciar un Procedimiento afiadido, requieren una
confirmacion a través de una ventana emergente.

= Una desviacion del flujo de trabajo que omite un Procedimiento critico incompleto
requiere una confirmacion y una respuesta de texto por parte del usuario que
indique el motivo de la desviacion.

6.3.2. Testigo de etiquetas “nivel de muestras”

NOTA: las etiquetas de nivel de muestras (etiquetas Wrap-around y etiquetas Gavi 7-set)

se observan de la misma manera que las etiquetas de nivel de ciclo del paciente. Estas
etiquetas no activaran una falta de coincidencia a nivel de muestra a menos que se vinculen
especificamente a un ciclo, como durante un FET. Los escaneos testigo realizados en
distintas etiquetas de nivel de muestra durante los procedimientos de biopsia (por ejemplo,
placa posterior a la biopsia y tubo de transferencia de tejido para el embrion incorrecto)

se registraran en el escaner portatil y en el Informe del testigo, pero no activaran una
incompatibilidad.

El nimero de muestra (es decir, el nimero de embrién) para las etiquetas de nivel de muestras
se registra en el escaner portatil en el momento del escaneo y también en el Informe testigo.

6.3.3. Testigo manual de etiquetas”

Si, por algun motivo, no es posible escanear un cédigo de barras durante una Sesion de
testigo, es posible realizar un Testigo manual para la etiqueta, para garantizar que queda
registrada como parte de la Sesion de testigo.

NOTA:

» Una segunda persona (testigo) con ID de usuario es quien debe realizar el Testigo
manual.

= Para realizar un Testigo manual, ya debe haber comenzado una Sesion de testigo.

= Durante un proceso de Testigo manual, el escaner cerrara su sesion
automaticamente tras 120 segundos de inactividad.
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Para realizar un Testigo manual:

1.
2.

3.

4.

5.

Pulse . Se muestra la pantalla «<Manual Witness» (Testigo manual).

Introduzca la ID de paciente para la etiqueta para la que realiza el proceso de
testigo manual.

Especifique el Tipo de contenedor en el menu desplegable. (NOTA: Si se
selecciona un procedimiento que contiene una etiqueta Gavi 7-set, se requiere un
numero de muestra).

Haga que el testigo verifique que la informacion introducida en la pantalla coincide
con la etiqueta.

El testigo debe escanear o introducir su ID de usuario.

La etiqueta quedara registrada como parte de la Sesion de testigo y aparecera en la pantalla
«Witness Session» (Sesion de testigo) identificada como realizada con testigo manual. La ID
de usuario del segundo testigo también sera registrada.

6.4. Revisar la Informacion de paciente

6.4.1. Revisar la informacion del progreso de laboratorio
Para revisar la informacion del progreso de laboratorio:

1.

3.

Seleccione el Dia de ciclo deseado de la pantalla «Active Patients» (Pacientes
activos). Aparece la pantalla «Cycle Day» (Dia de ciclo), que muestra todos los
pacientes que se encuentran actualmente en ese dia del Ciclo y su estado.

Pulse en cualquier entrada de paciente para visualizar su informacion relacionada,
incluyendo el Progreso diario para los Procedimientos relevantes para ese dia y las
Sesiones de testigo para ese paciente ordenadas por Procedimiento.

Pulse < para regresar a la pantalla «Cycle Day» (Dia de ciclo).

6.4.2. Revisar la informacion de paciente individual
Para revisar la informacion de paciente:

1.

Pulse «Patient History» (Historial de paciente) en el menu desplegable ubicado en
la esquina superior izquierda de la pantalla «Active Patients» (Pacientes activos).
Se muestra la pantalla «Patient History» (Historial de paciente).

Escanee cualquiera de los codigos de barras de etiqueta del paciente. Se muestra
la informacion relacionada con el paciente, incluyendo el Progreso diario para

los Procedimientos relevantes para ese dia y las Sesiones de testigo para ese
paciente ordenadas por Procedimiento.
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6.4.3. Audio del escaner portatil

Gidget proporciona sefiales de audio durante el escaneo para minimizar la necesidad de
mirar la pantalla del escaner portatil

) Jt

Gidget

Pitido alto
Please enter your PIN
o) Pitido alto-bajo . e = 2R
s Tesoasens..  asersos
Gender
PItIdO ba'o 19810922 Female  12345676.. Day3
A 00 4 2 3
-@ Pitido corto y alto 4 5 6
) il IR G El pitido alto-bajo indica al | ... us -
— No hay sonido 7 8 9 usuario que se requiere una
raRs o warz > e
accion en la pantalla tactil. Por | procedurec
0 e lo general, esto se relaciona
. o Container type, #6, Linked Cycle #
con la seleccion del siguiente | eensianeotvame oo
procedimiento

Un pitido [Red

—_ v~ | altoindicaun
Day0 —— 20f10 A 123456789012345678... 12345678901 123456789012345678... 12345678901
de testificacion [ 2 ol Toque en [ s e o some
1981-09-22. 12345678... Day3 o 1981-09-22 Female 12345678... Day3
normal Confirmar
Dayl 30f9
Procedure A Procedure A
Day2 —_— 50f7 +> _—
Container type Container type
TSRO, Pt hame, 008 LTS Paert e 005
LT P— A
Container type Container type
T oo N s o
Day4 — 40of7
Container type Container type
assrmozssron (] SO ©
Days v
Container type (1 of X) Container type (1 of X)
i eSOl
DAY6 10f5
Container type (2 0f X) Container type (20fX)
T2
Day7 p— 7

Al caducar la sesién de
testificacion, suena un
pitido corto y alto

?

A

Unscheduled start Patient error

A

User session expired

The patient is not scheduled to You cannot scanlabels o this
starton todays date. If required, patientdueto a prior patient
please amend the start date label mismatch. Resolve the
using the web app. issue using the web portal to
continue scanning labels for
Your session has timed this patient.
out. You have been

logged out. o«

Si se ignora un pitido alto-bajo y se continta con el escaneo, se
activara un pitido bajo de error. Continuara sonando hasta que se
haya atendido el mensaje en la pantalla tactil.

NOTA: El audio para los errores, tales como la falta de
concordancia del paciente, es el mismo que para las advertencias.
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Senales de audio de registro de los consumibles

5:08AM
Tr.
Incoming v Scan aconsumable label..
Day 0 _— 20f10
Escanee una etiqueta
Dayl 30f9 de un articulo de
consumo
Day2 —_— 50f7
Day3 — A
Day4 — 40f7
Day5 v
Day6
Day7 c—
Toque en Menu Toque en Seguir articulos

de consumo

Las sefales de audio para el
seguimiento de articulos de

consumo son similares a las de e
un testi go, en el que un doble Scan aconsumable label 12345678901234567890123456 7890
: S S O e
. . . . . Manufacturer
pitido alto-bajo indica al usuario Genea Bomedx
que se requiere una accion en la Foriisation media -
L Fenleafnimeds &, Lot 123456 7850123456 T850123456785012345
.pantalla tactil [RT——"
Eptydne Lot 1234567890123456T850123456785012345
2017-09-22 Expiry Date YYYY-MM-DD
Lot# 1234567690123456T880123456755012345
o Bl DatoYMNDD
fetive ° S ——
Bl Date VMDD
Lot# 1234567890123456T850123456785012345
[r——
Lot# 1234567890123456T880123456755012345
By Date MDD

Lot # 12345678901234567890123456789012345
Consumable linked to cycles. Expiry Date YYW.MM-DD.

Cierre sesion Rellene los campos y Toque en + para afadir un lote
toque en Confirmar de articulos de consumo

8:08AM = 8:08 AM

Link Lot to Cycles: = Consumable Tracking

Scan a consumable label...

Lotk Lot#
123456789012345678901234567890123456789012345 123456789012345678901234567890123456789012345
Expiry Date Expiry Date.

YYYY-MM-DD YYYYMM-DD

Patient Name

Scan a patient label to link. Patient ID, Dob, Cycle #

PatientName

Patient D,bob Cyce Advertencia &

Cycle already linked

This cycle hasalready been inked
tothe consumable.

20 , .
El usuario escanea una o mas Toqge en Cierre sesion
etiquetas de paciente validas Confirmar
para vincularlas con el lote de

articulos de consumo
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6.5. Control manual del Estado del dia de ciclo

Gidget realiza un seguimiento de todas las etiquetas escaneadas y actualiza el estado del
paciente automaticamente en base a las normas de flujo de trabajo asignadas por el usuario.

B 8:08 AM 100% -

M Patient History

Patient # Cyclett
123456789012345678...  1234567890-1

OB Gender  Cycletype  Stage
1981-0922 Female  12345678.. Day3

Day Incomplete

Procedure A

Only today’s procedures and witness

Sessions are o

web app to t
history.

B @
[ comneoce [

®
NOTA:

= Las normas de flujo de trabajo determinan qué tareas requieren que se registre una sesién
de testigo como completada para cada Dia de ciclo. Una vez realizadas las sesiones
de testigo para esas tareas, Gidget registra automaticamente el Dia de ciclo como
completado, y el usuario ya no debe realizar ninguna otra operacion. Sin embargo, Gidget
también permite el control manual completo del Estado del dia de ciclo si es necesario.

* Los cambios del estado del Dia de ciclo se pueden deshacer si es necesario.

Para cambiar manualmente el estado del Dia de ciclo:

1. Pulse «Patient History» (Historial de paciente) en el menu desplegable ubicado en
la esquina superior izquierda de la pantalla «Active Patients» (Pacientes activos).
Se muestra la pantalla «Patient History» (Historial de paciente).

2. Escanee cualquiera de los cédigos de barras de etiqueta del paciente. Se muestra
la informacion relacionada con el paciente, incluyendo las Sesiones de testigo para
ese paciente ordenadas por Procedimiento.

3. Pulse @ en la esquina inferior derecha de la pantalla y seleccione @& (Completar
dia) o @ (Reanudar dia).

6.6. Finalizacion del ciclo

PRECAUCION: Una vez un Ciclo se registra como completado, ya no puede deshacerse
esta operacion.

Para completar un Ciclo de paciente en el escaner:

1. Pulse «Patient History» (Historial de paciente) en el menu desplegable ubicado en
la esquina superior izquierda de la pantalla «Active Patients» (Pacientes activos).
Se muestra la pantalla «Patient History» (Historial de paciente).

2. Escanee cualquiera de los cédigos de barras de etiqueta del paciente. Se muestra
la informacion relacionada con el paciente, incluyendo las Sesiones de testigo para
ese paciente ordenadas por Procedimiento.

3. Pulse @ enla esquina inferior derecha de la pantalla y seleccione Q.
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7. ALERTAS DE ERROR

7.1. Error de correspondencia de paciente

Un error de correspondencia de paciente se produce si se escanean etiquetas de

paciente no vinculadas durante la misma Sesién de testigo. También se producira una
incompatibilidad del paciente entre las etiquetas del mismo paciente impresas en dos
ciclos distintos. Se debe tener cuidado al realizar ciclos activos simultaneos desde el
mismo paciente donde se utilizan los mismos tipos de contenedores al mismo tiempo.

En la pantalla «Active Patients» (Pacientes activos), tanto en el escaner como en la aplicacion
web, la tarjeta de paciente relevante estara resaltada en rojo y aparecera al principio de la
lista. El error debe resolverse para poder realizar mas Sesiones de testigo para ese paciente.

NOTA: Solo los administradores y supervisores de laboratorio pueden resolver un Error
de correspondencia de paciente. Si se produce este error, hable con su supervisor o
administrador de laboratorio.

Para resolver un Error de correspondencia de paciente:

1. Haga clic en la Tarjeta de paciente afectada, en color rojo. Se muestra la pantalla
«Review Patient» (Revisar paciente).

2. En la caja de texto, introduzca la informacion relacionada con las circunstancias del
error (NOTA: esta explicacion quedara registrada y sera visible en los Informes de
auditoria).

3. Hagaclicen " para poder realizar mas Sesiones de testigo para ese paciente.

7.2. Error de incompatibilidad de muestra

El error de incompatibilidad de muestra se produce cuando se escanea una etiqueta de
un ciclo anterior y la etiqueta no se ha vinculado al ciclo activo. En la pantalla Pacientes
activos, tanto en el escaner como en la aplicaciéon web, la Tarjeta del paciente relevante se
resaltara en rojo y aparecera en la parte superior de la lista. El error debe resolverse antes
de que se puedan realizar mas Sesiones de Testigos para ese paciente. Se puede ver

una lista de muestras vinculadas validas que se pueden analizar a través de la aplicacion
web de Gidget en la pestafa «Linked Cycles» (Ciclos vinculados) de la seccion «Review
Patient» (Revisar paciente).

Sample mismatch

The sample number does not
match. You will now be logged
out. Resolve the issue using the
web app to continue scanning
labels for this patient.

OK
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NOTA: Solo un administrador de laboratorio o un supervisor puede resolver un Error
de incompatibilidad de muestra. Si se produce este error, consulte a su supervisor de
laboratorio o administrador.

Para resolver un error de incompatibilidad de muestra:

1. Haga clic en la tarjeta roja del paciente afectado. Se muestra la pantalla seccién
«Review Patient» (Revisar paciente).

2. En el cuadro de texto, ingrese los detalles relacionados con las circunstancias del
error (NOTA: esta explicacion se registrara y sera visible en Informes).

3. Hagaclicen o para permitir mas sesiones de testigos para ese paciente.

7.3. Advertencia de ciclos restantes

Una Advertencia de ciclos restantes se produce cuando se alcanza el nimero minimo de
Ciclos restantes especificado por el usuario. Aparecera una ventana emergente instando
al usuario a adquirir una nueva Licencia. Si aparece esta advertencia, hable con su
supervisor o administrador de laboratorio.

«Cycles Remaining» (Ciclos restantes): muestra los Ciclos restantes en la Licencia actual.
Una vez guardada la Informacion de ciclo del paciente, el nimero de Ciclos restantes en
su Licencia actual se reduce en 1 o en 0,5 en funcion del valor del Ciclo. Si cancela un
Ciclo, el numero de Ciclos restantes en su Licencia actual recupera 1 o 0,5 en funcién

del valor del Ciclo. Esta informacion puede consultarse en las pantallas «Active Patients»
(Pacientes Activos) y «Licenses» (Licencias).
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8. GLOSARIO

«Active Cycle» (Ciclo activo):

Hace referencia a cualquier Ciclo de paciente para el que se estén realizando procesos de
laboratorio. A partir de la primera Sesion de testigo completada y hasta que el Ciclo esté
registrado como completado. Los Dias de ciclo se siguen del Dia O al Dia 7.

«Pantalla Active Patients» (Pacientes activos):

La pantalla de Pacientes activos ofrece un resumen de todos los pacientes que tienen un
Ciclo activo en curso actualmente, organizados por Dia de ciclo. Esta pantalla también
muestra los pacientes cuyo inicio de procesos de laboratorio esta programado para el dia
laboral actual.

«Concurrent Cycles» (Ciclos simultaneos):
Los ciclos simultdneos son dos o mas ciclos que estan activos o programados al mismo
tiempo para un solo paciente en cualquier funcion.

«Critical Labels» (Etiquetas criticas):

Las etiquetas criticas se utilizan en un Procedimiento para activar la finalizacion del
Procedimiento en un Dia de ciclo determinado. Durante los procesos de laboratorio, una vez
escaneadas todas las etiquetas para un Dia de ciclo, la Tarjeta de paciente relevante de la
pantalla «Active Patients» (Pacientes activos) aparecera como completada (verde con sefial
de aprobacién). Esto permite una visibilidad completa del progreso del paciente a lo largo
del dia. Si un Procedimiento no contiene ninguna etiqueta critica se marcara como completo
tras finalizar la Sesion de testigo y pulsar @ en el Escaner portatil.

«Critical Procedures» (Procedimientos criticos):

Los Procedimientos criticos se utilizan para activar una advertencia y obtener una
respuesta de desviacion del usuario cuando se omiten. Cuando se selecciona un
Procedimiento diferente al siguiente Procedimiento previsto en el Dia de Ciclo, aparecera
una advertencia para indicar al usuario que se esta omitiendo un Procedimiento. Si se
trata de un Procedimiento critico, sera obligatorio introducir una respuesta de desviacion
en el Escaner portatil para poder continuar con la Sesion de testigo. Si el Procedimiento
omitido no esta marcado como critico, se mostrara la advertencia pero no se requerira una
respuesta de desviacion del usuario. En ambos casos, el evento se registra en el Historial
de informes del Ciclo.

«Cycle» (Ciclo):

El Ciclo hace referencia al momento especifico en que comienza un proceso de paciente
(bien con la recogida de un ovocito o con la descongelacion de un embrion) y en el que
termina (bien cuando el embrion se transfiere a una paciente o cuando el embrion se
congela).

«Cycle Type» (Tipo de ciclo):
Los Tipos de ciclo se utilizan para identificar los Procedimientos y etiquetas requeridas para
los Tipos de ciclo estandar.

«Cycle Sufifx» (Sufijo del ciclo):

El sufijo del ciclo es un campo de un solo caracter que aparece después del numero de
ciclo y esta separado por un guion en el ciclo de laboratorio de Gidget. Se utiliza para
distinguir ciclos simultaneos para el mismo paciente de cada uno donde se usa el mismo
numero de ciclo. Cuando el nimero de ciclo se comunica a bases de datos externas,

Pagina 42 de 63 QIFU-GIDG-ES-1-01



MANUAL DE INSTRUCCIONES DE GIDGET

como las EMR, solo se transmite el numero de ciclo base. El sufijo del ciclo se puede
establecer en cualquier caracter alfanumérico antes del inicio del ciclo.

«Gidget WebApp» (Aplicacion web Gidget):

La Aplicacion web Gidget es un paquete de software propietario basado en la web que
se utiliza para crear, gestionar y atestiguar muestras de paciente y procesos de flujo de
trabajo en un laboratorio de embriologia.

«Incoming» (Entrante):
Un paciente aparece como Entrante si el inicio del Dia O de su proceso de laboratorio esta
programado para el dia laboral actual.

«Lab Process» (Proceso de laboratorio):
Hace referencia a la funcion de software que le permite configurar Gidget conforme a su
flujo de trabajo y sus procesos de laboratorio individuales.

«Label Formats» (Formatos de etiquetas):
Los Formatos de etiquetas son plantillas con contenido personalizable que se pueden
asignar a una o mas etiquetas.

«Label Library» (Biblioteca de etiquetas):

La Biblioteca de etiquetas es un conjunto completo de etiquetas de contenedores
y documentos que requieren un proceso de testigo para TODOS los Ciclos y
Procedimientos realizados en el laboratorio de embriologia.

«Labels» (Etiquetas):

Las Etiquetas son adhesivos que contienen informacion del usuario o el paciente con
un codigo de barras con matriz de datos que se puede escanear y seguir a lo largo del
proceso de laboratorio.

«License» (Licencia):

Las licencias de Gidget son necesarias para cada ciclo utilizado en el sistema Gidget y
pueden adquirirse en lotes de 50, 100 y 1000 ciclos. Se proporciona una clave de licencia
con cada licencia.

«Linked Patients» (Pacientes vinculados):

Los Pacientes vinculados son pacientes adicionales que un usuario vincula a un
Propietario durante un Ciclo. Los pacientes permanecen vinculados hasta que el Ciclo
guede registrado como completo o se cancele.

«Multi-Part Label» (Etiqueta multicomponente):

Hace referencia a etiquetas que se utilizan para contenedores que tienen dos partes (por
ejemplo, una tapa y un contenedor). Durante una Sesion de testigo es obligatorio escanear
consecutivamente las dos partes de una Etiqueta multicomponente.

«Oocyte Donor» (Donante de ovocito):

Esta Funcion de paciente se utiliza si se asocia a una Donante de ovocito con el Ciclo.
«Owner» (Propietario):

El Propietario es la Funcion de paciente principal designada en el Ciclo. El Propietario es

normalmente la madre o, cuando los Ciclos implican un Subrogado, la receptora del bebé
tras el nacimiento.

«Partner/Sperm Donor» (Pareja/Donante de esperma):
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Esta es una Funcién de paciente que debe especificarse en un Ciclo como Pareja o como
Donante de Esperma.

«Patient Card» (Tarjeta de paciente):

La Tarjeta de paciente se muestra en la pantalla Active Patients (Pacientes activos), y
ofrece un resumen de la informacion relacionada con los pacientes de un Ciclo activo.
Una Tarjeta de paciente en gris indica que no se han escaneado todas las etiquetas
criticas para el Dia de ciclo de ese paciente. Una Tarjeta de paciente en verde indica que
se han completado todas las tareas especificadas para el Dia de ciclo de ese paciente.
Una Tarjeta de paciente en rojo indica que se ha producido un error critico que se debe
resolver.

«Patient Mismatch Error» (Error de correspondencia de paciente):
Un Error de correspondencia de paciente es una alerta critica que se produce si se
escanean dos etiquetas de paciente no vinculadas durante la misma Sesion de testigo.

«Patient Role Applicability» (Aplicabilidad de funcién de paciente):

La Aplicabilidad de funcion de paciente se utiliza para asignar tipos de etiquetas a
Funciones de paciente, para garantizar que se imprime la informacion de paciente correcta
en la etiqueta. También garantiza que se imprime el niumero correcto de etiquetas para las
funciones de paciente en el ciclo.

«Patient Role» (Funcion de paciente):
Se utiliza para designar las distintas funciones de un paciente dentro de un Ciclo, por
ejemplo, Propietario, Pareja/Donante de esperma, Donante de ovocito o Subrogado.

«Primary Patient» (Paciente primario):
Un paciente primario es el término usado para describir colectivamente al propietario y al
donante en un solo ciclo de funciones.

«Procedure» (Procedimiento):

Los Procedimientos son tareas que se realizaran como parte de un Ciclo estandar, por
ejemplo, TESE.

«Procedure Type» (Tipo de procedimiento):
Son conjuntos de etiquetas requeridos para contenedores y documentos durante un
Procedimiento.

«Report» (Informe):

Los informes contienen un registro completo de las actividades completadas con el
Escaner portatil Gidget, incluidas todas las sesiones de testigos, errores, advertencias

y sesiones incompletas. Los informes de «Witness Session» (Sesion testigo) y «Cycle
History» (Historial del ciclo) se pueden exportar como PDF. El informe de consumibles se
puede exportar como un documento PDF o CSV.

«Scheduled» (Programado):
Hace referencia a todos los pacientes que tienen informacion de Ciclo preparada y cuyo
inicio del Dia O est4 programado para un dia distinto al dia laboral actual.

«Stock» (Repertorio):
El repertorio hace referencia al papel, la marca, el tipo y las dimensiones de las etiquetas
utilizadas en una impresora.

«Surrogate» (Subrogado):
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Esta Funcion de paciente se utiliza si la madre biologica es distinta a la que consta como
Propietario.

«User ID» (ID de usuario):
La ID de usuario es un Nombre de usuario Unico o etiqueta con codigo de barras que
permite a un usuario iniciar sesion en el sistema de Gidget.

«Witness Session» (Sesion de testigo):

Una Sesion de testigo reemplaza cualquier situacion que requeriria normalmente la
presencia de una segunda persona que actue como testigo de una tarea. Una Sesion

de testigo se realiza escaneando las etiquetas asociadas a una tarea. Al hacer esto,
Gidget verificard que todas las etiquetas escaneadas coincidan con el paciente o con los
pacientes vinculados dentro de un Ciclo.

«Workflow Rules» (Normas del flujo de trabajo):

Estas normas hacen referencia a etiquetas criticas especificadas por el usuario que deben
escanearse para que los Procedimientos, y posteriormente el Dia de ciclo del paciente,
queden registrados como completados. Una vez escaneadas todas las etiquetas criticas
para el Dia de ciclo de un paciente, la Tarjeta de paciente pertinente aparecera en la
pantalla Active Patients (Pacientes activos) como completada (indicado por una sefial de
aprobacion y resaltado en verde).

«Workflow» (Flujo de trabajo):
El flujo de trabajo hace referencia al orden de los pasos que se debe seguir en el
laboratorio para el desarrollo de un embrion durante un Ciclo de paciente.

9. ESPECIFICACIONES TECNICAS Y MAN-
TENIMIENTO

Para obtener mas informacion sobre las especificaciones técnicas, el cumplimiento de
los limites de compatibilidad electromagnética (CEM) y otros aspectos relacionados con
el uso, el mantenimiento y el almacenamiento de los componentes de hardware que se
suministran con Gidget, consulte la documentacion relevante del fabricante entregada
durante la instalacion del sistema Gidget.

Para obtener informacion basica sobre la limpieza y el mantenimiento de los componentes
de Gidget, consulte la documentacion relevante del fabricante entregada durante la
instalacion del sistema Gidget.
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10. REQUISITOS PREVIOS Y RESPONSABI-
LIDADES

10.1. Requisitos previos

A continuacion se incluye una lista que ofrece una descripcion de los principales requisitos
previos para usar el sistema Gidget. NOTA: Estos elementos no se suministran con
Gidget y debe proporcionarlos el cliente. Para acceder a la lista completa de requisitos,
equipamiento, tareas y responsabilidades, consulte el Formulario de preinstalacién para el
cliente en el Manual de servicio de Gidget (QFRM898). Puede solicitar este formulario al
personal del servicio técnico autorizado de Genea.

Monitor montado
en pared

Recomendado

Detalles

Dispositivo de
almacenamiento
de datos
electrénicos
para copias de
seguridad

Requerido

Pese a que se prevé que la mayor parte de los clientes
incorporen Gidget en las redes existentes de su laboratorio, los
clientes también pueden optar por crear una red independiente
exclusivamente para Gidget (p. ej., a través de un router
convencional con conectividad WiFi).

Requisitos minimos:

= Conexion WiFi en todas las areas en las que se utilizara Gidget
para permitir la conexion de Gidget a los Escaneres portatiles
inalambricos.

= Debe existir un nimero suficiente de puertos Ethernet para
permitir la conexién del Sistema de computacion central de
Gidget (CCS) a las impresoras de etiquetas.

= Deben permitir la comunicacién entre el Sistema de
computacién central de Gidget (CCS) y el resto de dispositivos
(como Escaneres portatiles, impresoras y dispositivos de
almacenamiento).

Funciones de red recomendadas:

* DHCP habilitado. (Motivo: simplifica la conexion de dispositivos,
incluidos los Escaneres portatiles Gidget y las impresoras de etiquetas).

= Conexion a Internet (Motivo: permite la sincronizacion horaria y
facilita la conexion de los Escaneres portatiles Gidget).

Impresoras de
etiquetas

Requerido

Tipo: Zebra GX430t o Brady BBP12 con conexion Ethernet.

Cantidad requerida: Una impresora para cada tamario y tipo de
etiqueta que se vaya a imprimir.

NOTA: No es recomendable disponer de una Unica impresora
para multiples tamafios y tipos de etiqueta, ya que en ese caso
los embridlogos deberian cambiar continuamente las diferentes
etiquetas en la impresora.

Periféricos de
ordenador para el
sistema CCS de
Gidget

Requerido

Elementos: Etiquetas, cinta de transferencia y rodillos de impresion.

NOTA: Actualmente, la eleccion de etiquetas y otros consumibles
de impresora se limitan a un conjunto de opciones especifico
(véase “11.2. Impresoras de etiquetas y consumibles compatibles”

en la pagina 48).

Pagina 46 de 63

QIFU-GIDG-ES-1-01




MANUAL DE INSTRUCCIONES DE GIDGET

Ordenador con Recommended Resolucién minima de pantalla de 1080p con conexion WiFi y

navegador capacidad de conexion mediante modo Quiosco. Para acceder
al navegador Chrome, el cliente también necesitara conectar al
monitor un PC en una memoria USB o un ordenador portatil o de
sobremesa..

Chrome (version Requerido Para fines de recuperacion de fallos.

51 o posterior) Tipos de dispositivos de almacenamiento compatibles:
= Memoria externa USB.
= Unidad de red.

Espacio requerido: Hasta 140 MB por copia de seguridad.
Espacio recomendado: Hasta 1 GB para permitir siete copias
de seguridad por defecto..

Periféricos de Requerido = Teclado USB.

ordenador para el = Raton USB.

g?éergf CCS de = Monitor con cable HDMI.

g = Cables Ethernet.

Ordenador con Requerido Los usuarios de Gidget deben acceder a la interfaz de usuario de

navegador la aplicacion web Gidget mediante un ordenador conectado a la

Chrome (version misma red que Gidget.

51 o posterior) Requisitos del ordenador:

* Debe estar conectado a la red Gidget.
= Debe tener instalado el navegador Chrome.

ID de Apple Requerido La primera vez que se instalan los Escaneres portatiles Gidget se
conectaran brevemente a la Apple Store a través de Internet. Esta
operacion requiere que cada emplazamiento del cliente disponga
de su propio ID de Apple (véase ““11.2.1. Crear un ID de Apple”
en la pagina 48).

Red WiFi con Requerido La primera vez que se instalan los Escaneres portatiles Gidget

conexion a solo durante la se conectaran brevemente a la Apple Store a través de Internet.

Internet instalacion NOTA: No es necesario habilitar esta conexién en la red del
laboratorio. Los Escéneres solo se conecta brevemente a Internet
para su activacion y a continuacion se desconectan.

10.2. Responsabilidades del cliente

El cliente es responsable de todos los aspectos de las siguientes tareas (incluyendo
adquisicion, configuracion, funcionamiento, mantenimiento y seguridad):

= Configuracién y mantenimiento de la red en la que opera el sistema Gidget.

= Configuracién y mantenimiento de las impresoras de etiquetas, incluyendo la
instalacion y la sustitucion de consumibles.

= Configuracion y mantenimiento de los dispositivos de almacenamiento y todas las
copias de seguridad.

Para obtener instrucciones de preinstalacion detalladas: véase ““11. PREINSTALACION”

en la pagina 48.

Para obtener instrucciones de posinstalacion detalladas: véase ““12. POSINSTALACION”
en la pagina 52.
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11. PREINSTALACION

11.1. Descripcidén general

Para preparacion la instalacion, los clientes deben cumplimentar el Formulario de
preinstalacion para el cliente que se incluye en el Manual de servicio de Gidget (QFRM898).

El Formulario de preinstalacion para el cliente esta disponible previa solicitud, y el
personal del servicio técnico autorizado se lo facilitara a los clientes autorizados de Genea
como parte del proceso normal de preinstalacion. El formulario contiene los pasos y la
informacién necesaria para completar con éxito la instalacién, incluyendo la adquisicion y
configuracion de todo el equipamiento requerido.

La instalacion del sistema Gidget debe realizarla exclusivamente personal del servicio
técnico autorizado. NOTA: El personal del servicio técnico autorizado solicitard una copia
cumplimentada del Formulario de preinstalacion para el cliente con anterioridad al dia de
instalacion acordado.

El resto de este apartado proporciona una descripcion general e instrucciones adicionales
para ayudar a los clientes a cumplimentar el Formulario de preinstalacion para el cliente.

11.2. Impresoras de etiquetas y consumibles compatibles

PRECAUCION:

Los consumibles que se vayan a utilizar con Gidget deben seleccionarse
A EXCLUSIVAMENTE de las listas siguientes, incluyendo los tamarnos de los

consumibles y el fabricante/proveedor especifico. Genea tiene previsto ampliar
esta lista en consonancia con los comentarios recibidos de los clientes, pero en
este momento no existen otras soluciones compatibles.

Dado que cada fabricante utiliza ligeras variaciones en el repertorio y el formato, NO utilice
ningun consumible no autorizado, ya que es muy probable provoque errores de impresion
de etiquetas (p. ej., las variaciones en el espacio entre etiquetas en los rollos podria
provocar que la informacién impresa no se imprima sobre las etiquetas).

NOTA: Para obtener la informacion mas reciente relacionada con los consumibles
admitidos, consulte: QRTM212 Gidget Consumables.

11.2.1. Crear un ID de Apple

La primera vez que se instalan los Escaneres portatiles Gidget se conectaran brevemente

a la Apple Store a través de Internet. Esta operacién requiere que cada emplazamiento

del cliente disponga de su propio ID de Apple. En el momento de redaccion de este

documento, los ID de Apple podian crearse de forma gratuita en appleid.apple.com

NOTA:
= Es necesario crear un ID de Apple con anterioridad al dia de instalacion.

= Puede utilizarse un unico ID de Apple para un maximo de diez Escaneres portatiles
Gidget simultaneamente.

= UnID de Apple es una cuenta establecida con la empresa Apple.

= El dia de la instalaciéon debe estar disponible un representante del cliente para
indicar el nombre de usuario y la contrasefia del ID de Apple para cada Escaner
portatil.
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11.3. Configuracion de impresora Zebra GX430t con

conexion Ethernet

Este apartado proporciona instrucciones para configurar la impresora Zebra GX430t con
conexion Ethernet y prepararla para la instalacion de Gidget.

NOTA:
= Estas instrucciones se ofrecen a titulo orientativo y NO sustituyen a la documentacion

del fabricante de la impresora.

= Por defecto, la impresora Zebra GX430t imprimira etiquetas de prueba que no resultan
visibles debido a un ajuste insuficiente del nivel de oscuridad. Los siguientes pasos
garantizaran una impresion correcta de las etiquetas.

= Enalgunos de los pasos siguientes se le pedira que pulse y mantenga presionado
el boton de alimentacion de la impresora hasta que el indicador de estado verde
parpadee un numero especifico de veces. Mantener presionado el botén de
alimentacion de la impresora hara que el indicador pase por un ciclo de “grupos de
parpadeo”; parpadeara primero una vez, luego dos veces, luego tres veces, etc. Por
ejemplo, si se le pide que pulse y mantenga presionado el botdn de alimentacion de

= laimpresora hasta que parpadee rapidamente cinco veces debera mantener el boton
presionado hasta que la impresora llegue al ciclo de cinco parpadeos antes de soltarlo.

= En algunos pasos debe estar preparado para pulsar el boton en un plazo de
tiempo breve. Lea todas las instrucciones antes de comenzar.

Pasos de configuracion de la impresora recomendados:
1. Siga las instrucciones del fabricante para instalar las etiquetas de la impresora.
2. Siga las instrucciones del fabricante para instalar la cinta de la impresora.

3. Encienda la impresora y espere a que el indicador luminoso sea de color verde (fijo
o parpadeante).

4. Pulse brevemente el botdn de alimentacion una vez. La impresora se alimentara
con una serie de etiquetas en blanco.

NOTA: Verifique que el indicador se ilumine de color verde fijo (no parpadeante) antes de
continuar. Si sigue parpadeando, pulse el botén de alimentacion brevemente una vez. Si
el indicador continua parpadeando, podria haber un problema con la instalacion de los
consumibles (consulte la documentacion del fabricante).

Para configurar los ajustes de nivel de oscuridad:

5. Pulse y mantenga presionado el boton de alimentacion de la impresora hasta que
parpadee rapidamente seis veces y libérelo. Esto hara que la impresora imprima
etiquetas sucesivas con niveles de oscuridad cada vez mayores. NOTA: Las
primeras etiquetas impresas apareceran en blanco (véase a continuacion).

et e |
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6. Permanezca atento. Cuando la impresora alcance un ajuste de nivel de oscuridad de
25, pulse brevemente el botdn de alimentacion una vez para seleccionar el ajuste.

NOTA: Para imprimir caracteres mas finos, como los caracteres arabes o de lenguas
asiaticas, podria ser necesario un ajuste mas oscuro para lograr la legibilidad deseada.

Para configurar los ajustes de anchura de etiquetas:

7. Pulse y mantenga presionado el boton de alimentacion de la impresora hasta que
parpadee rapidamente cinco veces y libérelo. Esto hara que la impresora imprima
etiquetas sucesivas de cada vez mayor anchura (véase a continuacion).
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[ ETY NX(ST‘
HEy NIT
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i

8. 8. Permanezca atento. Cuando la impresora alcance una anchura cercana a
los bordes de su etiqueta, pulse brevemente el boton de alimentacion una vez para
seleccionar el ajuste de anchura. NOTA: En este paso no es necesario lograr un
nivel de ajuste preciso, ya que el objetivo es obtener una anchura aproximada para
permitir la impresion de una etiqueta de prueba.

O |

Para imprimir una etiqueta de prueba y localizar la direccion IP actual de la impresora:
9. Conecte la impresora a una red con DHCP habilitado mediante un cable Ethernet.
10. Espere diez segundos para permitir que la impresora obtenga una direccion IP de

la red. NOTA: La impresora no indicara el éxito o fracaso de la operacion, de modo
que continde con el siguiente paso después de diez segundos.

11. Pulse y mantenga presionado el botén de alimentacion de la impresora hasta que
parpadee una vez y libérelo. Se imprimira una etiqueta de prueba.

12. Verifique que el aspecto de la etiqueta impresa es semejante al de la imagen que
se muestra a continuacion.

{
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13. Localice la direccion IP actual de la impresora en la etiqueta de prueba impresa.

Para asignar a la impresora una direccion IP estatica:
14. Conecte un ordenador a la misma red que la impresora.

15. Abra un navegador.
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16. Introduzca la direccion IP actual de la impresora (que se muestra en la etiqueta
de prueba impresa) en la barra de direcciones del navegador y pulse Intro. Se
mostrara la pagina de inicio de Zebra Printer Management.

17. Seleccione «Print Server Settings» (Ajustes del servidor de impresion) en la
pagina de inicio.
18. Seleccione «Print Server» (Servidor de impresion). Si se solicita una contrasefia,
los datos por defecto son:
— Nombre de usuario: admin
— Contrasefa: 1234
19. Seleccione «TCP/IP Configuration» (Configuracion TCP/IP).
20. Introduzca los cambios necesarios, incluyendo:
— Direccion IP: <Introduzca la direccion IP estatica que desee asignar>
— Protocolo IP: Permanente
— Mascara de subred: <Segun la red>
— Pasarela por defecto: <Segun la red>
21. Seleccione «Submit Changes» (Enviar cambios) y siga las indicaciones de reinicio
de la impresora.
Para confirmar que la impresora tiene asignada la direccion IP estatica deseada:
22. Conecte un ordenador a la misma red que la impresora.
23. Abra un navegador.

24. Introduzca la direccion IP estatica en la barra de direcciones del navegador y pulse
Intro.

25. Confirme que se muestra la pagina de inicio de Zebra Printer Management.

11.4. Configuracion de impresora Brady BBP12 con

conexion Ethernet

Para consultar las instrucciones de configuracién de la impresora, descargue el
documento «Brady_BBP12_Printer_Setup.pdf» la pagina de asistencia técnica del

fabricante: www.qualityserviceandsupport.com/brady/article/7498
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12. POSINSTALACION

12.1. Descripcion general

Este apartado describe las tareas, incluyendo la creacion de copias de seguridad para
recuperacion de fallos, que los clientes deben realizar después de la instalacion para
garantizar el correcto funcionamiento de Gidget.

12.2. Tarea de posinstalacion recomendada

N.° | Descripcion Conforme a

1 Realizar una copia de seguridad manual de Gidget. | “12.4.4. Realizar una copia de seguridad
manual” en la pagina 55.

2 Confirmar el correcto funcionamiento de las copias | “12.4.3. Configuracién de la hora y la

de seguridad automaticas de Gidget. frecuencia de las copias de seguridad” en la
pagina 55.
3 Confirmar que los archivos de las copias de Procedimientos de Tl especificos del cliente.

seguridad automaticas de Gidget se guardan en los
sistemas de copias de seguridad de la clinica.

12.3. Datos de inicio de sesion del cliente
El cliente dispone de los siguientes datos de inicio de sesion:

Nivel de sistema | Nombre de Contrasena Uso previsto

usuario predeterminada
Gidget CCS Admin G!dG3T4dm1n! | Administrador de Tl del cliente. Para todas las tareas
Windows de posinstalacion de Gidget realizadas a nivel de

Windows, incluyendo la realizacion de copias de
seguridad, restablecimiento y adicion de impresoras.

Gidget CCS Dashboard D4shbo4rd! Permite mostrar la aplicacion web Gidget.
Windows
Gidget Web App | Consulte la Consulte la Administrador del cliente. Para todas las tareas

documentacion | documentacion | de posinstalacion de Gidget realizadas en la
de instalacion de instalacion Gidget WebApp (Aplicacion web Gidget),
incluyendo afiadir nuevos usuarios y asignar
nuevos permisos de administrador.

12.4. Copia de seguridad y recuperacion de fallos

PRECAUCION:

La restauracion desde una copia de seguridad puede ocasionar la pérdida de datos de
A trabajo. Se perdera cualquier trabajo (p. ej., testigo, nuevos Ciclos o historial de auditoria)
o cambio realizado en Gidget Web App (Aplicacion web Gidget) con posterioridad a la
creacioén de la copia de seguridad. Ademas, el sistema Gidget no reconocera ninguna
etiqueta de Ciclos o Procedimientos creada con posterioridad a la copia de seguridad.

El sistema Gidget CCS guarda copias de seguridad diarias de la base de datos de Gidget
WebApp (Aplicacion web Gidget) en una ubicacion especificada por el usuario para fines
de recuperacion de fallos. Cada copia de seguridad consiste en un Unico archivo con la
extension .7z (p. ej., gidget-2016-11-10.bak.7z)
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La copia de seguridad y la restauracion de la base de datos de Gidget WebApp se
realizan ejecutando scripts en Gidget CCS. La restauraciéon desde una copia de seguridad
anterior sustituira la base de datos de Gidget existente con la base de datos de la copia
de seguridad, incluyendo:

* Procesos de laboratorio
— Biblioteca de etiquetas
— Procedimientos y Tipos de Ciclo
— Normas del flujo de trabajo
* Informacion del Paciente e informacion del Ciclo
— Todos los pacientes y ciclos activos e histéricos
— Historial de testigo y registros de informes
= Usuarios
— Permisos
— |Dy datos de acceso
= Configuracion general

12.4.1. Preguntas frecuentes sobre copias de seguridad y restablecimiento

1. P: éCuanto espacio de almacenamiento requieren los archivos de las copias de
seguridad?
R: El tamafio de la base de datos aumenta con el nimero de Ciclos realizados,
por lo que el espacio de almacenamiento requerido dependera de la frecuencia y
el tiempo de uso del sistema Gidget. Como referencia, se calcula que el tamafio
de archivo de las copias de seguridad de Gidget aumenta en 100-200 MB al
ano. Por defecto, Gidget realizara una copia de seguridad cada dia y permite el
almacenamiento de hasta siete archivos de copia de seguridad en la ubicacién
especificada (se borraran los archivos mas antiguos). Esto supone asignar entre
0,7 GBy 1,4 GB de espacio por afio de uso de Gidget. NOTA: Estos datos son
meras aproximaciones, por lo que es responsabilidad del administrador de Tl del
cliente monitorizar y posibilitar la realizacion de las copias de seguridad requeridas.
2. P:éSon incrementales las copias de seguridad?
R: No, cada copia de seguridad contiene una copia de la base de datos en su conjunto.
3. P: No puedo abrir el archivo .7z porque Gidget solicita una contrasefa. éDe qué
contrasefa se trata?
R: No se requieren ni se facilitan contrasefas para los archivos de copia de seguridad
de Gidget (.bak.7z). Deberia poder realizar la restauracion sin esta contrasefia.

4. P:éQué informacion no se incluye en las copias de seguridad de Gidget?
R: Ciertos datos no se incluyen en los archivos de copia de seguridad y
restauracion. NOTA: Estos datos no requieren la creacién de copias de seguridad
por parte del usuario y solo se mencionan a titulo informativo. Los datos no
incluidos en las copias de seguridad incluyen:
— Archivos de registro del sistema Gidget, ubicados en C:\GidgetData\Logs
— La aplicacion Gidget, ubicada en C:\Installs

— Los ajustes del calendario de las copias de seguridad automaticas,
accesible a través del Administrador de tareas de Windows

— Las versiones de la aplicacion escaner portatil de Gidget.
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12.4.2. Asignar la ubicacion de las copias de seguridad

NOTA: Durante la instalacion se asigna una ubicacion designada por el cliente a las copias
de seguridad. A continuacion se facilitan instrucciones para que el usuario pueda cambiar

esta ubicacion.

Para asignar una ubicacion de copias de seguridad:

1. Inicie sesion en Windows en el sistema Gidget CCS utilizando una cuenta con

permisos de administrador.

2. Localice el archivo C::\Management-Scripts\config.json mediante el Explorador

de Windows.

3. Abra el archivo config.json con un editor de texto (como Bloc de notas).

4. Edite la entrada “backupPath” para que incluya la ruta de acceso completa a la
carpeta en la que desee almacenar las copias de seguridad de Gidget. Asegurese

de que:

a. Todas las rutas de acceso a una ubicacion de red (como una unidad de red
asignada) se introducen como ruta de acceso UNC completa y NO mediante

una letra de unidad asignada.

b. Los caracteres de barra invertida en la ruta de acceso estan acompafados de
un caracter de barra invertida adicional.

c. Sila ubicacion de copias de seguridad requiere credenciales de inicio de

sesion (como en una ubicacion en

red), se facilitaran.

Ejemplo de ubicacion de copias de seguridad
deseada

Coémo deberia aparecer en el archivo config.json

Unidad de red que no requiere credenciales:
\\geneaserver001\GidgetBackups

“backupPath”: “\\\\geneaserver001\\
GidgetBackups”,

“backupUser”: ",
“backupPwd": “",
“numberOfBackupsToKeep” : 7

Memoria USB conectada directamente a Gidget
CCs:

D:\Gidget_baks

“backupPath”: “D:\\Gidget_baks",
“backupUser”: *",

“backupPwd": “",
“numberOfBackupsToKeep” : 7

Unidad de red que requiere credenciales:
\\clinicXYZserver002\GidgetArchive

Ejemplo de nombre de usuario: clinicXYZadmin
Ejemplo de contrasefia: admin1234

“backupPath”: “\\\\clinicXYZserver002\\
GidgetArchive”,

“backupUser”: “clinicXYZadmin”,

“backupPwd": “admin1234",
“numberOfBackupsToKeep” : 7
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12.4.3. Configuracién de la hora y la frecuencia de las copias de seguridad

NOTA: Por defecto, Gidget crea una copia de seguridad cada dia a las 3:00 (hora local).
Esta operacion se realiza mediante el Programador de tareas de Windows en el sistema
Gidget CCS, que ejecuta una tarea denominada «Gidget DB Backup». Esta tarea ejecuta el
mismo script de copia de seguridad que se utiliza al crear una copia de seguridad manual.

Para ajustar la hora y la frecuencia de las copias de seguridad:
1. Inicie sesién en Windows en el sistema Gidget CCS utilizando una cuenta con
permisos de administrador.

2. Abra el Programador de tareas de Windows (escriba «Programador de tareas»
en la barra de busqueda de Windows).

3. Localice la tarea Gidget DB Backup en el panel de Tareas activas.

4. Haga doble clic en la tarea. Ahora podra editar los «Triggers» (Desencadenadores)
de esta tarea a través de «Properties» (Propiedades). Si no esta seguro de como
hacerlo, consulte la documentacion de Windows Server 2012,

5. Confirme que Gidget esta realizando estas copias de seguridad correctamente
verificando que se crea un archivo de copia de segurldad (p- €j.,
gidget-2016-11-18.bak.7z) en la ubicacion de copias de seguridad especificada
con la marca de tiempo prevista.

12.4.4. Realizar una copia de seguridad manual

NOTA:

= En este apartado se describe como realizar inmediatamente una copia de
seguridad de los datos del sistema Gidget a la ubicacién especificada en el
archivo config.json.

= Si se realiza mas de una copia de seguridad el mismo dia, solo se conservara la
copia de seguridad mas reciente (la copia de seguridad mas reciente sobrescribira
la copia de seguridad mas antigua).

Para realizar una copia de seguridad manual:
1. Inicie sesion en Windows en el sistema Gidget CCS utilizando una cuenta con
permisos de administrador.
2. Abra Windows Powershell ISE como administrador, como se indica a continuacion:
a. Escriba Powershell en la barra de busqueda de Windows.
b. Localice el icono Windows Powershell ISE en los resultados de la busqueda.
c. Haga clic con el boton derecho y seleccione Ejecutar como administrador.

3. Vaya al directorio C:\Management-Scripts\Backups\
(es necesario estar familiarizado con los comandos de la linea de comandos. Si
tiene alguna duda, consulte la documentacion de Windows Powershell).

4. Escriba el comando: .\db_backups.ps1
Confirme que el script ha finalizado, se mostrara un mensaje de éxito.

o

6. Confirme que se ha creado un archivo de copia de seguridad con la fecha del dia
actual en la carpeta en la que deberia haberse realizado la copia de seguridad
(segun lo especificado en el archivo config.json). Puede hacerlo mediante el
Explorador de Windows (no es necesario utilizar PowerShell).

QIFU-GIDG-ES-1-01 Pagina 55 de 63



GENEA BIOMEDX

12.4.5. Realizar una restauracion

PRECAUCION:

= No debe accederse al sistema Gidget mientras se lleva a cabo una restauracion.
Si se utiliza Gidget durante una restauracion se desconectard a los usuarios de
su sesion. Pese a ello, la restauracion deberia completarse con éxito.

& = Larestauracion desde una copia de seguridad puede ocasionar la pérdida de

datos de trabajo. Se perdera cualquier trabajo (p. ej., testigo, nuevos Ciclos o
historial de auditoria) o cambio realizado en Gidget Web App (Aplicacion web
Gidget) con posterioridad a la creacion de la copia de seguridad. Ademas, el
sistema Gidget no reconocera ninguna etiqueta de Ciclos o Procedimientos
creada con posterioridad a la copia de seguridad.

Para realizar una restauracion:

1. Asegurese de que el archivo de copia de seguridad se encuentra en el directorio
asignado en el archivo config.json (véase “12.4.2. Asignar la ubicacion de las
copias de seguridad” en la pagina 54).

2. Abra una ventana de Powershell como administrador (escriba Powershell en la
barra de busqueda de Windows, haga clic con el botén derecho en el icono de
Windows Powershell y a continuacion seleccione Ejecutar como administrador).

3. Enlaventana de Powershell, vaya al directorio C:\Management-Scripts\Backups\
(es necesario estar familiarizado con los comandos de la linea de comandos. Si tiene
alguna duda, consulte la documentacién de Windows Powershell).

4. Escriba el siguiente comando:
\db_restore.ps1 <nombre del archivo de copia de seguridad>
donde <nombre del archivo de copia de seguridad> es el nombre del archivo
desde el que va a realizarse la restauracion.

Ejemplo:
Si desea realizar una restauracion a partir del archivo «gidget-2016-11-10.bak.7z», escriba
el siguiente comando: .\db_restore.ps1 gidget-2016-11-10.bak.7z

5. Responda afirmativamente a todos los avisos.

6. Confirme que el script ha finalizado y vuelva a la ventana de Windows PowerShell,
que no debe contener mensajes de error.

7. Inicie sesion en Gidget Web App (Aplicacion web Gidget) para confirmar que la
restauracion se ha realizado con éxito.

12.4.6. Anadir, modificar o eliminar impresoras de etiquetas
Pongase en contacto con el representante del servicio técnico autorizado de Genea.

12.4.7. Anadir Escaneres portatiles adicionales
Pongase en contacto con el representante del servicio técnico autorizado de Genea.
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12.4.8. Importar un proceso de laboratorio provisto por Genea (opcional)
PRECAUCION::

= No se debe acceder al sistema Gidget mientras se lleva a cabo la operacion
de importacion del proceso de laboratorio. Si se usa Gidget durante una
importacion del proceso de laboratorio, los usuarios se desconectaran, sin

f embargo, la importacion deberia completarse con éxito.

= Un nuevo proceso de laboratorio solo se puede importar a un nuevo sistema
Gidget que nunca haya tenido pacientes ni ciclos. Si existe algun dato, la
importacion fallara y el proceso de laboratorio no se actualizara.

= Laimportacion de un proceso de laboratorio reemplazara cualquier
configuracion de proceso de laboratorio existente, lo que incluye etiquetas,
procedimientos y tipos de ciclos

Para importar un proceso de laboratorio provisto por Genea:

1. Asegurese de que el archivo de proceso de laboratorio provisto por su
Representante de Servicios Genea autorizado esté ubicado en el directorio al que
se puede acceder desde el Gidget CSS. Tome nota de la ruta completa de este
archivo.

2. Abra una ventana de Powershell como administrador (escriba Powershell en la
barra de busqueda de Windows, luego haga clic con el boton derecho en el icono
de Windows Powershell y luego seleccione Ejecutar como administrador).

3. En la ventana de Powershell, navegue al directorio C:\Management-Scripts\
Backups\ (debera estar familiarizado con los comandos de la linea de comandos.
Si no esta seguro, consulte la documentacion de Windows Powershell).

4. Ingrese el siguiente comando: \labconfig_import.ps1 <nombre del archivo del
proceso de laboratorio> donde <nombre del archivo del proceso de laboratorio>
es la ruta completa y el nombre del proceso de laboratorio para importar.

Ejemplo:

Si desea importar el archivo de proceso de laboratorio llamado ‘gidget

labconfig-2016-11-10.bak.7z’ en una unidad externa USB disponible en D:\Gidget_

labprocess, escriba el comando:

A\Labconfig_import.ps1 D:\Gidget_labprocess\gidget-labconfig-2016-11-10.bak.7z
5. Responda si a todas las preguntas.

6. Confirme que la secuencia de comandos se completo y regreso al indicador de
Windows PowerShell sin mensajes de error.

7. Confirme que la importacion se ha realizado con éxito iniciando sesion en la
aplicacion web de Gidget y verificando las etiquetas, procedimientos y tipos de
ciclo esperados en el area de Configuracién de laboratorio.
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12.5. Escaneres portatiles: Verificar la version de la
aplicacién web

Para verificar la version de la Gidget WebApp (Aplicacién web Gidget) en los
Escaneres portatiles:

1. Pulse el botdn de inicio en un Escaner portatil Gidget. Se mostrara el sistema
operativo OS Desktop.

2. Pulse Ajustes > General > Almacenamiento y uso de iCloud > Gestionar
almacenamiento. Se mostrara la pantalla de almacenamiento.

3. Localice y seleccione Gidget en la lista. Se mostrara una pantalla con informacion.

4. Localice la version de la aplicacion Gidget.

12.6. Recuperar archivos de registro del sistema

NOTA: Los archivos de registro pueden ser utiles en caso de un fallo del sistema. No

se prevé que el servicio de Tl del cliente necesite interpretar y depurar los archivos de
registro, pero el representante del servicio técnico autorizado de Genea podria solicitar la
recuperacion y el envio de los archivos de registro.

Para recuperar los archivos de registro del sistema:

1. Inicie sesion en Windows en el sistema Gidget CCS utilizando una cuenta con
permisos de administrador.

2. Localice los archivos de registro en el siguiente directorio:
C:\GidgetData\Logs

12.7. Eliminar todos los datos de pacientes

A

PRECAUCION:

El sistema Gidget CCS contiene datos confidenciales de los pacientes. En la
mayor parte de regiones, la manipulacion de estos datos y de los sistemas que lo
contienen esta regulada por la legislacion.

Pongase en contacto con el representante del servicio técnico autorizado de Genea.
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13. INDICE ALFABETICO
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Configuracion de impresora Brady BBP12,

Ciclos de paciente, 24
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finalizacion del ciclo, 40 ) ) )

L Configuracién de impresora Zebra GX430t,

imprimir etiquetas para, 26 49

vincular pacientes, 24 configuracion de anchura de etiquetas, 50
Copia de seguridad, 52 consumibles compatibles, 48

copia de seguridad manual, 55 eliminar, 56

Preguntas frecuentes, 53 impresoras compatibles, 48

restauracion, 56
ubicacion de copias de seguridad, 54

Informacion de paciente

revision, 37
D Inicio de sesidn,
Direccion IP, aplicacién web, 22
estatica, 50 nombres de usuario, 49
E L
Errores, Labels,
advertencia de ciclos restantes, 41 Single European Code (SEC) 29
falta de correspondencia de paciente, 41 Licencias,
Escaner, anadir nuevas licencias, 9

afiadir escaneres portatiles, 56 solicitar nueva, 9

funcionamiento basico, 33 Linking Samples, 24

inicio de sesién, 34

N

Normas del flujo de trabajo,
crear normas, 16

Estado del dia de ciclo (escaner),
control manual, 40

Etiquetas,
anadir a la biblioteca de etiquetas, 11 P
afiadir a un procedimiento, 14 Pantalla de Pacientes activos, 22
dar f.o.rmato, 11 Printer,
modificar formatos, 11 Zebra GX430t setup,

darkness setting, 48

QIFU-GIDG-ES-1-01 Pagina 59 de 63



GENEA BIOMEDX

Procedimientos, 13
afadir procedimientos, 13
procedimientos criticos, 17

R
Realizacion 34

Restauracion,
desde una copia de seguridad, 56

S
Sesiones de testigo, 34
sesion de testigo manual, 36

Simbolos, 4

T

Tareas de cliente,
tareas recomendadas, 50

Tipo de Ciclo, 15
anadir etiquetas a, 16

U

Usuario,
imprimir una ID de usuario, 9
mi configuracion de usuario, 30
modificar informacién, 8
reactivacion, 8
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14. NOTAS
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